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OVERVIEW

To use ODBC, you must install the BASIS ODBC Drivers on a Microsoft Windows 95, Windows 98, 
Windows NT, or Windows 2000 machine. 

If your OSAS data is stored on a UNIX or LINUX drive, you will need software to map those drives 
as DOS drives or use a data server to access the OSAS data. 

After you install the ODBC drivers under Windows, you can use it to access your OSAS data, 
produce reports, and import OSAS data into other applications.

This course covers using ODBC with Excel. You will walk through examples of using Microsoft 
Query and creating PivotTables and spreadsheets in Microsoft Excel.

Before you can access the OSAS data using Microsoft Excel, you must set up any custom files, fields, 
and indexes using the OSAS ODBC Kit. You must also create a configuration file using the Edit 
CONFIG.TPM function or a text editor and install the BASIS ODBC Drivers in Windows.
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Files1

Use the Files function to set up and maintain data dictionary information about the data files used in 
OSAS programs, to construct views of the OSAS data files, and to delete unnecessary file definitions 
from the data dictionary

Dictionary Tools Menu - Files

1.For detail information on the Files function see the ODBC Kit Training Guide



-8

Set up in OSAS OVERVIEW



Set up in OSASOVERVIEW

-9

Fields2

Use the Fields function to define and edit the fields in the data dictionary files.

Dictionary Tools Menu

2.For detail information on the Fields function see the ODBC Kit Training Guide
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Indexes3

Use the Indexes function to define the keys used in OSAS Mkeyed data files.

Dictionary Tools Menu - Indexes

3.For detail information on the Indexes function see the ODBC Kit Training Guide
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Copy File(s) To Dictionary4

Use the Copy File(s) To Dictionary function to copy file, field, and index definitions from one set of 
data dictionaries to another; to create a copy of a data dictionary file name; and to rebuild the base 
tables.

Dictionary Tools Menu - Copy File(s) To Dictionary

4.For detail information on the Copy File(s) To Dictionary function see the ODBC Kit 
Training Guide
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Edit CONFIG.TPM

Use the Edit CONFIG.TPM function to create and edit database configuration files for use with the 
BASIS ODBC Driver. 

ODBC Kit Main Menu – Edit CONFIG.TPM

Select Edit CONFIG.TPM from the ODBC Kit menu.
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Edit CONFIG.TPM Selection Screen

To create a configuration file make the following selections:

Selection Description

Path and Name of 
CONFIG.TPM File

Enter the path and TPM file name to create. 

The path defaults to the C:/WINDOWS. You can accept this path and 
enter in the configuration file name1 or you can type in your own path 
and configuration file name.

1.  The configuration file does not have to have the name CONFIG.TPM. The file is an 8.3 Dos file 
and is only required to have the TPM extension, but can have any name you want.

File does not exist. Do 
you with to create?

Select Yes to create the configuration file in the selected path. 

Select No if you do not want to create the configuration file entered.
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Edit CONFIG.TPM Selection Screen

You can edit the configuration file by selecting the following:

Note

You must create a separate database configuration file for each company you want to access with the 
ODBC driver.

Variable Data

DICTIONARY1

1. The path entered must contain a drive letter and colon for the BASIS ODBC Drivers to access 
the OSAS data properly, unless you are using a data server. If you are using a UNIX or 
LINUX system and not using a data server, do not create a configuration file here (See Appen-
dix C).

The path to the ODBC data dictionaries. 

The default path is the RWdata directory setup with the Directories 
function in Resource Manager.

DATA1 The path to the OSAS data.

The default path is the Data1 directory setup with the Directories 
function in Resource Manager.

CID The company ID.

The company you are in defaults as the company ID

SYSFIL1 The path to the OSAS systems files. 

The default path is the SYSFIL directory setup with the Dictionary 
function in Resource Manager. 

Command Action

Enter = edit Enter to edit the line next to the cursor.

Append Line Select A to add a line to the configuration file.
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Adding Variables5

If you have OSAS data stored in the DATA2 or DATA3 paths, or you would like to access General 
Ledger data from previous years or last years Payroll data, use the Append option to add variables to 
the configuration file for those options.

Adding DATA 2 Variable

Use the Proceed command, PgDn or Esc P, to save the variable.

5.For more information on adding variables see the ODBC Kit Training Guide.

Field Description

Variable Enter the name of the variable you want to add to the configuration file. 

Add the variable name to the ODBC path in the Files function.

Data Enter any line data you need to associate with the current variable. If the 
variable represents a directory, make sure to end the path with a “/”.



Set up in OSASOVERVIEW

-19

In 6.1 and higher the variables for previous year General Ledger files and Last Year Payroll file are 
already added to the data dictionary files. To access those data files you must add the variables to the 
configuration file6. 

Current Year GLY Variable

For complete details on the GLY and PLY variables see Appendix D

Current Year PLY Variable

6. If you are using a version before 6.1 you will have to add the variables to the configuration file AND to 
the data dictionary files through the Files function.
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Edit CONFIG.TPM Selection Screen

Note

If you are using the 1.1 BASIS ODBC Drivers you must also run the Build Shadow Dictionary 
function (See Appendix A).

Command Action

Write Select W to write the configuration file.

Select Y, for Yes, to save the changes made to the configuration file.

Select N, for No, if you do not want to save the changes made or the 
configuration file.

CONFIG.TPM Name Select C to enter the path and file name for a new configuration file.
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Setup In Windows

To use ODBC, you must install and register the BASIS ODBC Drivers on a system with Microsoft 
Windows 95, Windows 98, Windows NT, or Windows 2000.

See ODBC Kit users guide for installation instructions.
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Microsoft Query

This section walks you through creating a query using the ODBC Kit and Microsoft Query 2000.

Microsoft Excel uses Microsoft Query in the background to select and import data with the BASIS 
ODBC Driver.
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Microsoft Query Using ODBC w/Excel

Creating a Query

Normally a short cut for Microsoft Query is not created on the Start Menu or the desktop.

To start Query, Click the Start Button and select Run. Browse to the Msqry32.exe program. The 
default path is “Program Files\Microsoft Office\Office\Msqry32.exe”.

You can use Find from the Start Menu to search for Msqry32.exe

Microsoft Query

Select New from the File menu.

Choose Data Source Screen

The Choose Data Source screen is displayed. 

Select the data source you want to use for this query or choose <New Data Source> if the one you 
want to use is not listed.

For this query highlight <New Data Source> and select the OK button.
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Create New Data Source Screen - Step 1

The Create New Data Source screen is displayed. 

There are four steps in creating a data source.

1. Enter a name for the data source you are creating. You can use any name for your data source.

Create New Data Source Screen - Step 2

2. Select the driver for the database you want to access. 

For the OSAS data files, select the BASIS ODBC Driver3.

3. If you are using the 1.1 version of the ODBC Drivers, select BASIS ODBC Driver 32-Bit.
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Create New Data Source Screen - Step 3

3. Connect to the data source configuration file. 

Click the Connect button. 
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BASIS ODBC Driver Data Source Configuration Screen

The BASIS ODBC Driver Data Source Configuration screen is displayed. 

1. Enter the path to the configuration file created in OSAS with the EDIT CONFIG.TPM 
function.

The Browse buttons is available to find the configuration file.
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BASIS ODBC Driver Data Source Configuration Screen

2. Under Options, make sure to place a check next to Pad variable length columns with 
spaces4.

4. This option is used if you have the Read/Write version of the BASIS ODBC Driver. Microsoft Query can 
write back to the OSAS data files, but Excel cannot.
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BASIS ODBC Driver Data Source Setup Screen

3. Under Dates in the Column Suffix(es) field, type in the word your OSAS Julian data fields end 
with. This will convert the OSAS Julian Date fields to display as regular dates. 

For standard OSAS data files enter DAT, DATE.5

Note

If you are using Data Server you must also enter a valid user in the Network User ID field.          
Root, Administrator, Admin and Supervisor are not acceptable to use with ODBC.

Click the OK button after the options have been checked, and if necessary, the Network User ID has 
been entered. 

See Appendix E for detail information on the BASIS ODBC Driver Data Source Setup.

5.Most Julian Date fields in OSAS end with the word DATE but in some installations the fields end with 
DAT.
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Create New Data Source – Step 4

The Create New Data Screen is re-displayed. 

4. Select an optional table (file) for your data source. This table is selected by default when you use 
this data source, but you can always select any table available.

You can also save your user ID and Password with this data source.

Click OK when finished.

Choose Data Source Screen

The Choose Data Source screen is re-displayed.

Place a check in the Use the Query Wizard to create/edit queries field, highlight the data source 
created and click OK.
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Query Wizard – Choose Columns Screen

The Query Wizard – Choose Columns screen is displayed. 

Select the tables and columns (files and fields) you want to use in your query.

Field Description

Available tables 
and columns

Displays a list of available tables and columns in the selected data source. 
Select the files and the fields to include in the query. 

Click the + next to the file name to expand the file and display all the 
fields within that file. 

To add a field to the query, highlight the field name and Click >. To add 
all the fields highlight the file name and Click >1.

For this query select the ARCU table.

1.  You can also double click the field names or the file name to add them to your query. 

Columns in your 
query

Displays the fields select for this query. 

To remove a field, highlight the field and Click <. To remove all the 
fields, Click <<

To change the order of the fields, highlight a field and select the up or 
down arrows to move the field.

Select the CUSTOMER_ID, CUSTOMER_ANME, 
ADDRESS_LINE_1, ADDRESS_LINE_2, CITY, STATE, 
ZIPA_CODE, ATTENTION, GROUP_CODE, CUSTOMER_LEVEL, 
SALES_REP_ID_1, SALES_PTD, SALES_QTD and SALES_YTD 
fields from the ARCU table.

Preview of data in 
selected column2

2.  This option does not work with the 2.3 and 3.0 BASIS ODBC Drivers.

Displays the data in the highlighted field under Columns in your query or 
Available tables and columns when you Click the Preview Now button. 

Options Select if you want to choose from Tables, Views, System Tables and 
Synonyms in the Available tables field. You can also select to sort the 
column and table names in alphabetical order.
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Query Wizard – Choose Columns Screen

Click the Next button to continue creating the query.

Command Action

Preview Now1

1.  This option does not work with the 2.3 or 3.0 BASIS ODBC Drivers.

Click to preview the data, of any highlighted field in Columns in your 
query or Available tables and columns, in the Preview of data in selected 
column field.

Back Not available in the Choose columns step.

Next Click to proceed to the next step of the query wizard.

Cancel Click to exit the query wizard. 
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Query Wizard – Filter Data Screen

The Query Wizard – Filter Data screen is displayed. 

Select the fields on which you want to impose criteria.

You can create filters for any of the fields selected for your query.

Filter data is an optional function.

Click the Next button.

Field Description

Column to filter Select the fields on which you want to impose criteria. 

Only include rows 
where – box 1

Select the operator for the criteria. 

Use the combo button to select from a list of available operators.

Only include rows 
where – box 21

1.  With the 2.3 and 3.0 BASIS ODBC Drivers you must manually type in the value to filter 
the data with. 

Enter the expression to compare against the field.

You can use the combo button to select from the data stored in the OSAS 
files. 

Command Action

Back Select to return to the previous step of the query wizard.

Next Click to proceed to the next step of the query wizard.

Cancel Click to exit the query wizard. 
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Query Wizard – Sort Order Screen

The Query Wizard – Sort Order screen is displayed. 

Select the fields by which you want to sort the query and the sort order.

You can sort by any of the selected fields for your query. 

Sort Order is an optional function.

Click Finish.

Field Description

Sort by Select the first field to sort by.

Then by Select additional fields to sort by.

This will create sorts within sorts on your query. 

Ascending 
Descending

If a sort is selected, select the sort order. 

Ascending order is A to Z, lowest to highest. Descending order is Z to A, 
highest to lowest. 

Command Action

Back Select to return to the previous step of the query wizard.

Finish Click to exit the query wizard and create the query.

Cancel Click to exit the query wizard. 
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Query 1 – ARCU Table

The query is displayed. 

The top section of the query displays the tables (files) used to create the query.

The bottom section shows the data contained in the columns (fields) of the query. 
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Deleting Columns

Query 1 – Deleting Columns

To delete a column, from the query, perform the following. 

Select the column to delete.

Select Delete from the Edit menu or press the Delete key.

Query 1 – Deleting Columns

The Column is deleted.
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Adding Columns

Query 1 – Adding Columns

To add a column, to the query, perform the following. 

Select the column you want to add from the table.

Drag and drop the select column in the position you want it to appear in on the query or double click 
to add it to the end of the query.

Query 1 – Adding Columns

The Column is added.
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Adding Criteria

Query 1 – Adding Criteria

To filter the data in the query, select Add Criteria from the Criteria menu.

Add Criteria

The Add Criteria box is displayed. Enter the following:

Field Description

And/Or If you are adding multiple criteria fields, select how the filters are connected. 

These fields are not available on the first criteria field.

Total Select the type of subtotal, if any, you want on the field.

Field Select the field to establish criteria on

Operator Select how you want to compare the Field to the Value
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Add Criteria

Select Value(s) Box

The OSAS data stored in the select field is displayed when you click the Values button.

Select the value you want to use in the criteria and click the OK button.

Field Description

Value Select the values to limit the field with. 

Add Click to add criteria to the query

Close Click to close the Add Criteria box

Values Click to select the Value field from a list.
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Add Criteria

The selection is added to the Value field.

Query 1

The added criteria are displayed in the middle area of the query and the data is filtered.
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Adding Tables - Automatic Join

Query 1 – Add Tables

To add a table to the query select Add Table from the Table menu.

Add Tables

The Add Tables box is displayed.

Field Description

Table Displays the list of available tables (files) in your data source. Select the table(s) 
you wan to add to the query.

Owner If you want the Tables box to only display tables created by a specific owner, select 
the name here. This field is available depending on the data source used to create 
the query.
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Microsoft Query Using ODBC w/Excel

Add Tables.

Select the ARHI_1 table and click the Add button.

Field Description

Database Select the database or location where the tables you want are stored. This field is 
available depending on the data source used to create the query.

Add Select to add the highlighted table to the query.

Close Select to close the Add Tables box after all the tables have been added to the query.

Options Select if you want to choose from Tables, Views, System Tables and Synonyms in 
the Available tables field. You can also select to sort the column and table names in 
alphabetical order.
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Query 1 - Table Added

The table is added to the query.

If the tables have a field in common, Microsoft Query will create a link or join between the tables 
automatically. 

The query creates a row for every record in the second table, per record in the first table.

In this example there is a row for every record in the ARHI_1 file per customer from the ARCU 
file, even though the data on the query is only from the ARCU file.

Joins

Select Joins from the Table menu or double click on the join between the tables to see how the tables 
are linked together.
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Joins

Field Description

Left Select the table and field you want on the left side of the join line. If the join is 
created automatically, Microsoft Query will select the table and field for this 
side.

Operator Select the comparison operator for the values in the Left and Right fields.

Right Select the table and field you want on the right side of the join line. If the join is 
created automatically, Microsoft Query will select the table and field for this 
side.

Join Includes Select the join option that specifies which records you want to retrieve and 
under what condition, based on the operator. The option you select determines 
if you have an inner or outer join type. An inner join returns related records 
from both tables. An outer join returns all records from one table and related 
records from the other table.

Joins in Query Displays statements defining the existing join types in the active query. If you 
have more than one join, Microsoft Query displays a separate statement for 
each.

Add Adds the join line between two tables in query. The Joins dialog box remains 
open so you can add more joins, if necessary.

Cancel/Close The Cancel button closes this dialog box without applying any changes you 
have made. The Close button closes this dialog box and retains the changes you 
made.

Remove Removes the join statement you've selected in the Joins in query box. 
Removing the join also removes the join line between the two tables in the 
query.
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Query 1 - Adding Columns from Table 2

To add columns from the additional table(s), drag the fields from the table and drop in the desired 
position in the query or double click the fields to add them to the end of the query. 

Add the Invoice Date and Invoice Number fields to the query.

Adding Criteria

When you have more than one table in the query the criteria is added by table and field ID

Select And to add the new criteria and leave Total blank

In Field select the ARHI_1.RECORD_TYPE.

In Operator select equals

In Value select L and click the Add button.

Close the criteria box.
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Removing Tables

Query 1 - Remove Table

To remove a table from the query, highlight any field within the table you want to remove and select 
Remove Table from the Table menu.

Query 1

The table is removed, along with any field and criteria from the table.
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Adding Tables - No Automatic Join

Sometimes when you add a table the join is not created automatically because Microsoft Query does 
not find the same field name in both of the tables. In those cases you will have to manually create the 
link between the tables.

Query 1 - Add Table

To add a table to the query select Add Table from the Table menu.

Add Tables

The Add Tables box is displayed. Select the table you want to add to the query and click the Add 
button. After adding the table(s) click the Close button.

Select the ARSR table and click the Add button.
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Query 1 - ARSR Table Added

The table is added to the query, but since the two tables do not have a field name in common, the join 
is not created automatically.

The query creates a row for every record in the second table, per record in the first table.

In this example there is a row for every record in the ARSR file per customer from the ARCU file, 
even though the data on the query is only from the ARCU file.

Query 1 - Adding Fields from ARSR Table

Add the SALES_REP_NAME field from the ARSR table. Add it after the SALES_REP_ID_1 field.

Since the query did not create the join automatically the Sales Rep Name does not necessarily 
correspond to the Sales Rep ID. 
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Query 1 - Creating A Join

To create a join, select the field from the first table, drag and drop it on the field in the second table or 
select Joins from the Table menu to create the link with the Joins box.

For the link between the ARCU and ARSR files, drag the SALES_REP_ID_16 field from the 
ARCU table and drop it on the SALES_REP_ID field in the ARSR table.

Warning Message

Because the fields have different names, Microsoft Query warns that the fields are different types and 
ask if you want to create the join anyway. 

Select Yes to create the join.

6.in this example you can also select the SALES_REP_ID_2 field from the ARCU file.
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Query 1 - Join between ARCU and ARSR

The join is created and the query updated to reflect the changes.

Only records where the ARCU SALES_REP_ID_1 field matches the ARSR SALES_REP_ID field 
are displayed, which was not the desired result. We were trying to get the join to keep all the records 
from the ARCU file but display the correct Sales Rep Name from the ARSR file 

We need to edit the join to include all records from the ARCU file but only the records that match in 
the ARSR file.

Double click the join or select Joins from the Table menu.

Joins Box

In the Joins Include area, change the join type from 1 to 2 and click the Add button. This changes the 
join from an inner to and outer join. 
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Warning Message

The warning message reappears. Click Yes to create the join.

Query 1

The query is now updated to display all the records from the Customer File (ARCU) and the 
matching records from the Sales Rep File (ARSR). 
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Read/Write ODBC

Query 1 - Allow Editing

If you have the Read/Write version of the BASIS ODBC Drivers you can change fields or add 
records in Microsoft Query and automatically change the field in OSAS.

To edit or add fields through Microsoft Query select Allow Editing from the Records menu.

Note

Use this option with extreme caution. Changing a field in Microsoft Query will automatically 
change the field in OSAS. There are no warning messages or prompts for the change. Once you 
leave the changed field, the OSAS field is updated.

Save Query

When you Exit query, you are prompted to save the query

Click Yes to save the query changes.

Click No if you do not want to save the changes.

Click Cancel if you do not want to exit the query 

Click Help to display help about Microsoft Query.
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Microsoft Excel

This section walks you through creating PivotTables and Worksheets using the ODBC Kit and 
Microsoft Excel 2000.
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PivotTables

The following example will walk you through all the steps necessary to set up a pivot table using the 
Accounts Receivable/Sales Order Customer File

Start Excel with a blank sheet. Select PivotTable and PivotChart Report from the Data menu.

Microsoft Excel – PivotTable and PivotChart Report 

There are 3 steps in creating a PivotTable Report. The PivotTable and PivotChart Wizard – Step 1 of 
3 is displayed7.

PivotTable and PivotChart Wizard – Step 1 of 3

Step 1 prompts for the location of your data source.

The OSAS data will always be an External Data Source.

Select External Data Source and click Next.

7. In Microsoft Excel 97 there are 4 steps to create a pivot table.
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PivotTable and PivotChart Wizard – Step 2 of 3, No data fields selected

Step 2 of 3 is displayed.

You are prompted for the location of the external data. 

No data fields have been retrieved is displayed next to the Get Data button.

The Next button is unavailable because data fields have not been selected.

Click the Get Data button to select the files and fields for the pivot table.

Choose Data Source Screen

The Choose Data Source screen is displayed. Choose the data source to use for the pivot table.

If you have not created a data source select <New Data Source> (See Appendix E)

Click OK to proceed.

For this pivot table choose the data source created earlier.
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The Query Wizard – Choose Columns screen is displayed.

 Query Wizard – Choose Columns

Select the tables and columns (files and fields) you want to access and use with in your query.

Click the Next button.

Field Description

Available tables and 
columns

Select the files and the fields to include in the query. 

Click the + next to the file name to expand the file and display all 
the fields within that file. 

To add a field to the query, highlight the field name and click >. 
To add all the fields highlight the file name and click >1.

Select the ARCU table. From the ARCU table, select the 
CUSTOMER_ID, STATE, GROUP_CODE, 
STATEMENT_CODE, DISTRIBUTE_CODE, 
TERMS_CODE, SALES_REP_ID_1, TERRITORY, 
CURRENT_AMT_DUE, BALANCE_31_60, 
BALANCE_61_90, BALANCE_91_120, 
BALANCE_OVER_120, UNAPPLIED_CREDIT, 
NEW_FINANCE_CHARGE, and UNPAID_FIN_CHARGE 
fields.

1.  You can also double click the field names or the file name to add them to your query. 

Columns in your query Displays the fields select for this query. 

To remove a field, highlight the field and click <. To remove all 
the fields, click <<
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The Query Wizard – Filter Data screen is displayed.

Query Wizard – Filter

Select the fields you want to impose criteria on.

You can create filters for any of the selected fields in your query. 

Filter data is an optional function.

Leave blank for this PivotTable

Click the Next button.

Field Description

Column to filter Select the fields in your query to setup criteria for. 

Only include rows 
where – box 1

Select the operator for the criteria. Use the combo button to select from a list 
of available operators.

Only include rows 
where – box 2

Enter the expression to compare the field to. You can use the combo button to 
select from the data stored in the OSAS files. 
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The Query Wizard – Sort Order screen is displayed.

Query Wizard – Sort Order

Select the fields by which you want to sort the query with and the sort order

You can sort by any of the selected fields for your query. 

Sort Order is an optional function.

Leave blank for this PivotTable

Click the Next button.

Field Description

Sort by Select the first field to sort the query with. Sorts are optional.

Then by Select additional fields to sort the query with. This will create sorts within 
sorts on your query. 

Ascending 
Descending

If a sort is selected, select the sort order. Ascending order is A to Z, lowest to 
highest. Descending order is Z to A, highest to lowest. 
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The Finish screen is displayed

Query Wizard – Finish 

Select where you would like to display the data.

Select Return data to Microsoft Excel

Click the Finish button.

Field Description

Return Data To Microsoft Excel Select to view the data on an Excel spreadsheet or PivotTable 
Report

View data or edit query in 
Microsoft Query

Select to start Microsoft Query to view or edit the data

Create an OLAP Cube from this 
query.

Select to create an OLAP data cube for this query.

Save Query Click to save the query for future use.
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The PivotTable and PivotChart Wizard – Step 2 of 3 screen is re-displayed. 

PivotTable and PivotChart Wizard – Step 2 of 3, fields selected

Data fields have been selected now.

Click on the Next button.

The PivotTable and PivotChart Wizard – Step 3 of 3 screen is displayed.8

PivotTable and PivotChart Wizard – Step 3 of 3

In Microsoft Excel 2000 and 2002 Step 3 asks where you want the pivot table.

Before selecting where to place the PivotTable, choose where to place the fields.

Click the Layout button to choose where you want the fields on the pivot table.

8.If you are using Microsoft Excel 97 this is Step 4 of 4 of the PivotTable Wizard.
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The PivotTable and Pivot Chart Wizard Layout screen is displayed.9

PivotTable and PivotChart Wizard – Layout Screen

Choose where you want your data to display within the pivot table. 

There are four different areas of a pivot table.

9. If you are using Microsoft Excel 97, this is Step 3 of 4.

Area Description

Page The fields listed here control the data for the entire pivot table

Row Displays data fields in rows going down

Column Displays data fields in columns going across

Data Displays the value for the fields selected in the Row and Column area
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PivotTable and PivotChart Wizard – Layout Screen

For this pivot table place the CUSTOMER_ID field in the ROW Area

Place the STATE, GROUP_CODE, STATEMENT_CODE, DISTRIBUTE_CODE, 
TERMS_CODE, SALES_REP_1 and TERRITORY fields in the PAGE Area

Place the NEW_FIN_CHARGES, UNPAID_FIN_CHARGES,CURRENT_AMT_DUE, 
BALANCE_31_60, BALANCE_61_90, BALANCE_91_120, BALANCE_OVER_120 and 
UNAPPLIED_CREDIT in the Data Area

PivotTable and PivotChart Wizard – Layout Screen

You can change the name of the fields by double clicking on the field and typing in a different name. 
The name you enter will display on the pivot table, but the Query will use the original field names.

You cannot change the field names to a name that is already in the Query or on the pivot table.

Once the fields have been placed on the pivot table, click OK.10

10. If you are using Microsoft Excel 97, click the Next button.
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The PivotTable and PivotChart Wizard – Step 3 of 3 screen is re-displayed.11

PivotTable and PivotChart Wizard – Step 3 of 3

Select where you would like to put the PivotTable. 

Click the Finish button.

Customer Balance PivotTable

The pivot table is displayed.

The fields added to the Page area are displayed in Column A with a dropdown box for each in 
Column B.

The Customers are displayed in the Row area with balances for each in the Data area.

The Customer Balances are shown in rows for each customer, in the data section.

Click the DATA heading and drag and drop it on the Total column.

11. If you are using Microsoft Excel 97 this is Step 4 of 4 of the pivot table Wizard.
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Customer Balance PivotTable

 Select different drop down boxes in the Page area to display specific data. 

Example: Select CA in the State dropdown box and Click OK.

STATE Dropdown Box

Customer Balance PivotTable

Only Customers and data for California are displayed.
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Customer Balance PivotTable

Select All in the State drop down box and select 0 for the Group Code Drop down box.

Customer Balance PivotTable

The next step is to add a column that calculates the total due amount for each customer.

Place the cursor on any field in the pivot table. Select Calculated Field from the Insert menu or right 
click and select Formula followed by Calculated Field.

Note

The Cursor must be in a a field in the Data section to insert the calculated field.
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The Insert Calculated Field box is displayed.

Insert Calculated Field

Select the Field name, Formula and Fields to use for the calculated field.

Field Description

Name Enter the name of the field you are creating or accept the default name. 

If you want to edit or modify an existing field, use the drop down box to select 
the field name.

Formula Enter or edit the formula for the field.

Fields Displays the fields available to use in the calculated field

Insert Field Click to add the selected field to the formula

Add/Modify Click to add a new calculated field to the pivot table or update an existing 
calculated field.

Delete Click to remove a calculated field from the pivot table

OK Click to exit Insert Calculated field and save the changes entered.

Close Click to exit Insert Calculated field.
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Insert Calculated Field

For this calculation enter Total for the Name.

In the Formula field enter 
=NEW_FIN_CHARGES+UNPAID_FIN_CHARGES+CURRENT_AMT_DUE+BALANCE_31_
60+BALANCE_61_90+BALANCE_91_120+BALANCE_OVER_120+UNAPPLIED_CREDITS

Click Add and OK.

Customer Balance PivotTable

The Total column is added to the PivotTable. The field label displays Sum of Total.
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Customer Balance PivotTable

Change the Total field label. 

Right click on the Sum of Total field and select Field Properties

PivotTable Field

Change the Name to Total Due and click OK.
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Customer Balance PivotTable

The new label is displayed.

Customer Balance PivotTable

Highlight and select all the amounts in the data section. 

Select Cells from the Format menu or right click and select Format followed by Cells.
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Format Cells

Select the Number tab.

Select Currency; accept the default Decimal places and Symbol. Choose how you want negative 
number to display and click OK.

Customer Balance PivotTable
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Next, add a new customer in OSAS

Accounts Receivable – File Maintenance

In the Sample Company select Accounts Receivable or Sales Order from the OSAS Main menu. 
Choose File Maintenance followed by Customers.

Accounts Receivable – Customers

Enter the new customer’s information
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Accounts Receivable – Customers

Enter balances for the customer.

Customer Balance PivotTable

From the Data menu in Excel, select Refresh Data. 

The cursor must be in an imported field to activate the Refresh Data option.
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Refresh Data

When new data is added to the pivot table you are given a prompt telling you the PivotTable has 
changed.

Click OK

Customer Balance PivotTable

The new customer is added to the PivotTable.
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Customer Drop Down

With Excel 2000 and 2002 you get drop down boxes for the fields in the ROW, COLUMN and 
DATA areas12. 

You can limit the information returned on the PivotTable by selecting and deselecting items in the 
drop down boxes.

After making your choices click OK

Customer Balance PivotTable

Move the Data column to display the totals for each customer in column B instead of rows. Click the 
Customer drop down and add all the customers to the pivot table.

12.This option is not available in Excel 97.
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Customer Balance PivotTable

With pivot tables you can highlight one field under Data and automatically highlight all the matching 
fields. 

Place your cursor on a field label until you see a dark arrow13. With the arrow displayed, click the 
field you want to highlight.14

Customer Balance PivotTable - Enabled Selection

Click the field and all corresponding matching records are highlighted.

13.If you are using Excel 97 click the field you want.
14.You may have to enable the field. To do this, right click on the field label or Data label. From the pop up 
menu, choose Select and click the Enable Selection option.
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Spreadsheets

Creating spreadsheets in Microsoft Excel using ODBC consist of 3 parts. 

1. Planning the spreadsheet

2. Linking to the data through ODBC and selecting the columns.

3. Formatting the columns on the spreadsheet. 

AR Collections Spreadsheet

Step 1: Planning the Spreadsheet

• First step in planning the spreadsheet is to decide what fields, or columns, you want on the 
report. After you select the columns for the spreadsheet, decide the order of the columns. 

• Decide which columns if any will have criteria, or filtering. 

• Decide the sort order for the fields. 

• Decide if there will be any added fields not associated with the OSAS data, such as calculated 
fields. 

Determining this information will help in deciding which file(s) to use for the report. 

This report will be an AR Collections Report based on the customer file. The report will contain all 
amounts due for the customer and a column will be calculated for the total amount due. Sorted by 
Sales Rep.

The fields for this spreadsheet will be Sales Rep ID 1, Customer ID, Customer Name, New Finance 
Charge, Unpaid Finance Charge, Current Amount Due, Balance 31-60, 61-90, 91-120, over 120 and 
Unapplied Credits. 
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Step 2: Linking to the data and selecting the Columns

Start Microsoft Excel with a blank spreadsheet

Microsoft Excel - Blank Spreadsheet

Next link to the OSAS data using the ODBC drivers. 

 Select Get External Data followed by New Database Query from the Data menu.15.

Microsoft Excel – Create New Query

15.With Excel 97 select Get External Data followed by Create New query. With Excel 2002 select Import 
External Data followed by New Database Query.
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Choose Data Source

The Choose Data Source screen is displayed. If you have a data source created, choose it here. If you 
do not have a data source created select <New Data Source> to create a data source. (See Appendix 
E)

For this spreadsheet select the data source created earlier

Query Wizard – Choose Columns

The Query Wizard – Choose Columns screen displays. Select the columns, or fields, you want on 
the spreadsheet.

For this spreadsheet from the ARCU table select SALES_REP_ID_1, CUSTOMER__ID, 
CUSTOMER_NAME, NEW_FIN_CHARGE, UNPAID_FIN_CHARGE, 
CURRENT_AMT_DUE, BALANCE_31_60, BALANCE_61_90, BALANCE_91_120 
BALANCE_OVER_120, and UNAPPLIED_CREDIT.

Select the Next button. 
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The Filter Data screen displays. Select the fields you want to impose criteria on. 

Query Wizard – Filter Data

Leave blank for this spreadsheet.

Select the Next button.

The Sort Order screen displays. You can sort the spreadsheet by any of the fields selected for the 
spreadsheet 

Query Wizard – Sort Order

For this spreadsheet select SALES_REP_ID_1 field and sort in Ascending order. 

Select the Next button.
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The Finish screen displays. 

Query Wizard - Finish

Select where you would like to display the data.

Select Return Data to Microsoft Excel and click the Finish button.

The Returning External Data To Microsoft Excel screen displays. Select where you would like to 
place the data.

Returning External Data to Microsoft Excel

Select Existing Worksheet. Place in cell A1 

Click the OK button. 
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The spreadsheet displays with the selected data.

ARCU Spreadsheet - Total Due Column

Step 3: Formatting the Columns

The next step is to create a column that calculates the total amount due.

Select the first cell in the first blank column (Cell L1 in this example), type Total Due and make it 
bold.

You can change the column heading for the OSAS fields also.

ARCU Spreadsheet - Total Due Column
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ARCU Spreadsheet - Total Due Column

Select the cell below the Total Due heading (cell L2 in this example). Create a math formula to total 
the New Fin Charges through Unapplied Credit fields. 

You can use the AutoSum function to total the cells or type in the formula

Enter the following formula =SUM(D2:K2).

ARCU Spreadsheet - Total Due Column

Press Enter to display the total for the calculation
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ARCU Spreadsheet - Total Due Column

Next, calculate the total due amount for the remaining cells in the Total Due column. There are 
several options to create the total. Enter the formula in each cell below L2 or use the AutoSum 
function for each cell. 

You can let Excel create the formula in the remaining cells. Select cell L2. Move the cursor to the 
lower right corner of the cell, until the cursor changes into a bold plus. Double click the corner to fill 
the remaining cells, or click and drag the bold plus down until the necessary cells are filled.

ARCU Spreadsheet – Total for each Column

Next, create a total for each of the balance amounts and a grand Total Due.

Select the first blank cell in the New Fin Charge column, cell D15 in this example. Use the AutoSum 
function to total cells D2 through D14 or enter a formula to total these cells. 

Enter the following formula =SUM(D2:D14)



86

Microsoft Excel Using ODBC w/Excel

ARCU Spreadsheet – NEW_FIN_CHARGE Total

Press Enter to display the total for the calculation.

ARCU Spreadsheet – Total for all Columns

Fill the remaining columns with the total. You can use the AutoSum function for each column or enter 
the formula for each column. 

You can also move the cursor to the lower right corner of D15 until the cursor changes to a bold plus. 
Click and drag the cell across until you are at cell L15 to fill the remaining cells with the total.
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You can format the cells to show the information in different ways.

ARCU Spreadsheet – Balance Fields Selected

Highlight all the balance columns and the Total Due column or highlight cells D2 through L15.

ARCU Spreadsheet – Format Cells

Select Cells from the Format menu or right click and select Format followed by Cells.
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Format Cells

The Format Cells dialog box is displayed.

 Select the Number tab.

Select Currency; accept the default Decimal places and Symbol. Choose how you want negative 
number to display and click OK.

ARCU Spreadsheet – Currency Display

Select the OK button to display amounts as currency in the spreadsheet.
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ARCU Spreadsheet – Data Menu - Subtotals

Next calculate a subtotal for each Sales Rep.

Select Subtotals from the Data menu.

Subtotals Dialog box

The Subtotal dialog box displays. Enter the following information:

Field Description

At each change in: Select the field you want to create the subtotals for. You can select any field 
on the spreadsheet

Select SALES_REP_ID_1 for this spreadsheet.

Use Function: Select how you want to total the fields. 

Select SUM for this spreadsheet
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Subtotals Dialog Box

Select the OK button to return to the spreadsheet.

Field Description

Add subtotal to: Place a check next to the fields you want to create subtotals for.

Select all the balance fields and the Total Due field.

Replace current subtotals Check if you want to replace any subtotals with the new ones you are 
creating.

Place a check here for this spreadsheet.

Page break between groups Check if you want each group and subtotal on a separate page.

Leave blank for this spreadsheet.

Summary below data Check if you want to subtotal below the data.

Place a check here for this spreadsheet.

OK Select the OK button to exit subtotals and save the changes

Cancel Select the Cancel button to exit subtotals without saving the changes.

Remove All Select the Remove All button to remove any subtotals.



Microsoft ExcelUsing ODBC w/Excel

91

ARCU Spreadsheet – Subtotals by Sales Rep

Scroll to the right to see the fields selected for subtotals.

ARCU Spreadsheet – Subtotals by Sales Rep
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General Ledger Balance Sheet 

Step 1 - Planning the Spreadsheet

First step in planning the spreadsheet is to decide what fields, or columns, you want on the report. 
Then decide what order you want the fields in, if there will be any added fields not associated with 
the OSAS data such as calculated fields, how the fields should be sorted, if criteria should be used. 
This will also help in deciding which file(s) to use for the report. 

This spreadsheet will be a GL Balance Sheet using the GLMA based on the BALA/BAL1 statement 
in OSAS. It will be created for period 1.

The fields on the spreadsheet will be the Account Number, Description, Debit/Credit/Memo Switch, 
Actual Beginning Balance, Actual Balance Period 1, Budget Beginning Balance, and Budget Balance 
Period 1. We will create calculated fields for the ending balance for period 1.

In the sample data:

Accounts 100000 through 199999 are asset accounts and accounts 200000 through 999700 are 
liability accounts. 

Accounts 100000 through 109999 are Current Assets

Accounts 150000 through 159999 are Long Term Assets

Accounts 180000 through 189999 are Other Assets

Accounts 200000 through 219999 are Current Liabilities

Accounts 250000 through 259999 are Long Term Liabilities

Accounts 300000 and higher are Equity Accounts.
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Step 2 – Linking to the data and selecting the Columns

The first step is to link to the data and select the columns for the spreadsheet; however we will add 
some text to the spreadsheet before we add the fields. 

Microsoft Excel – Blank Sheet

Start Microsoft Excel with a blank spreadsheet

General Ledger Balance Sheet

Type Assets in Cell A3 and make it bold.
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General Ledger Balance Sheet

Select Cells A3 through C3. Right mouse click and select Format Cells.

Format Cells

The Format Cells box is displayed. Select the Alignment tab and under Text control check the Merge 
cells box.

Click OK
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General Ledger Balance Sheet

The cells are now merged into one cell. 

Center the word Assets

General Ledger Balance Sheet

Two rows below Assets in Column B (cell B5 in this example) type Current Assets and make the 
words bold.
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General Ledger Balance Sheet

Now we are ready to add the fields for the spreadsheet.

Click the cell two rows below Current Assets in Column A (cell A7 in this example). Select Get 
External Data followed by New Database Query from the Data menu.16.

Choose Data Source

The Choose Data Source box is displayed. 

Select the data source you want to use to connect to the OSAS data and click ok. If you do not have a 
data source create, select <New Data Source> and click ok. 

Select the OSAS 612 DATA source created earlier

Check the box for Use the Query Wizard to create/edit queries.

16.With Excel 97 select Get External Data followed by Create New query. With Excel 2002 select Import 
External Data followed by New Database Query.



Microsoft ExcelUsing ODBC w/Excel

97

Query Wizard – Choose Columns

The Query Wizard – Choose Columns box is displayed. Select the table (file) and columns (fields) 
for the query. 

For this spreadsheet, select the GLMA table in the Available tables and columns field. Choose the 
GL_ACCOUNT_NUM, DESCRIPTION, DB_MEMO_CR_SWITC, ACTUAL_BEGIN_BAL, 
ACTUAL_BAL_PD_1, BUDGET_BEGIN_BAL, and BUDGET_BAL_PD_1 columns.

Click the Next button.

Query Wizard – Filter Data

The Query Wizard – Filter Data box is displayed.Select which fields (if any) on which to establish 
criteria.

Select the GL_ACCOUNT_NUM field. In the Only include rows where section. Select is greater 
than or equal to in the first box on the first row and enter 100000 in the second box on the first row. 
Click And. In the first box on the second row select is less than or equal to and enter 109999 in the 
second box on the second row. Click the Next button.
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Query Wizard – Sort Order

The Query Wizard – Sort Order box is displayed.

Select the order to sort the rows by. 

Do not sort this spreadsheet.

Click the Next button.

Query Wizard – Finish 

The Query Wizard – Finish box is displayed. 

Select where you want to put the data.

Select Return Data to Microsoft Excel and click the Finish button.
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Returning External Data to Microsoft Excel

The Returning External Data to Microsoft Excel box is displayed. 

Select where to place the data in Excel. 

For this spreadsheet, click the Properties button.

External Data Range Properties

The External Data Range Properties box is displayed. 

You can change the options for the Query definition section; the Refresh control section, the Data 
formatting and layout section, and how to fill in the data. 

Uncheck the Include field names option under Data formatting and layout and click OK We will add 
our own field names.
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Returning External Data to Microsoft Excel

The Returning External Data to Microsoft Excel box is re-displayed. 

The cell selected when we chose Get External Data should be displayed in the Existing worksheet 
field. Click OK.

General Ledger Balance Sheet

The data is returned from OSAS without column headings. 

Column A displays GL Account

Column B displays Description,

Column C displays Debit/Credit Switch,

Column D displays Actual Beginning Balance,

Column E displays Actual Balance for Period 1

Column F displays Budget Beginning Balance

Column G displays Budget Balance for Period 1
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Step 3 – Formatting the Columns and adding Excel features

Next we will create a total for the Actual and Budget Ending balances for Period 1

General Ledger Balance Sheet

In OSAS debit balances in debit accounts and credit balances in credit accounts are stored and 
displayed as positive numbers. Debit balances in credit accounts and credit balances in debit accounts 
are stored and displayed as negatives. If you create subtotals for assets and liability accounts using 
those numbers, you can end up with the wrong total.

In OSAS statements we use the Debit/Credit/Memo switch and the Reverse Sign to print function to 
determine the way numbers are displayed and calculated. In Asset accounts we want debit balances in 
debit account to display as positive numbers and credit balances in credit accounts to display as 
negative numbers.

In the Debit/Credit/Memo Switch field, a 1 means the account is a debit account and normally carries 
a debit balance, a -1 means the account is a credit account and normally carries a credit balance, and 
a 0 means the account is a memo account and carries no financial balance.

In Excel we will use the Debit/Credit/Memo Switch field to calculate our ending balances and create 
the subtotals correctly.

Use the Debit/Memo/Credit Switch, Actual Beginning Balance and Actual Balance Period 1 fields to 
create a calculated field adding the balances together and displaying them as debit or credit totals 
based on the type of account.

Select the first blank column (Column H in this example cell H7)

=SUM(D7:E7)*C7
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General Ledger Balance Sheet

Press Enter to display the total for the calculation.

General Ledger Balance Sheet

Fill the remaining cells in column H with the calculated total for actual ending balance. 
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The next step is to create a column to calculate the budget ending balance for period 1.

General Ledger Balance Sheet

Use the Debit/Memo/Credit Switch, Budget Beginning Balance and Budget Balance Period 1 fields 
to create a calculated field adding the balances together and displaying them as debit or credit totals 
based on the type of account.

Select the next blank column (Column I, cell 7 in this example).

=SUM(F7:G7)*C7

General Ledger Balance Sheet

Press Enter to display the total.
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General Ledger Balance Sheet

Fill the remaining cells in column I with the calculated total for budget ending balance.

General Ledger Balance Sheet

In cells H1 and I1 create column headings for the subtotals. 

For the Actual Ending Balance create a heading of Current Year and for the Budget Ending Balance 
create a heading of Budget. Format the cells any way you want.
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General Ledger Balance Sheet

In cells A1 and B1 create column headings for the Account Number and Description fields. Format 
the fields any way you want. 

Columns C through G will eventually be hidden so do not create column heading for those columns.

Next create subtotals for the Current Asset accounts.

General Ledger Balance Sheet

In column B, leave one row blank and enter Total Current Assets (Cell B18 in this example).

Format the cell any way you want.
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General Ledger Balance Sheet

Next to Total Current Assets in column H (cell H18 in this example) use the AutoSum function to 
create the Actual Current Assets total.

General Ledger Balance Sheet

Repeat the process to get the Budget Current Assets totals in column I (cell I18).
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General Ledger Balance Sheet

Format the totals.

Add a GL Account in OSAS to verify the totals will update correctly.

OSAS General Ledger – File Maintenance 

In Sample Data select General Ledger, File Maintenance, and GL Accounts to add a new account.
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General Ledger – File Maintenance - GL Accounts

Add a new GL Account within the range of Current Asset accounts for the spreadsheet and page 
down to save. 

Note

Remember the added account so it can be removed later.

General Ledger Balance Sheet

Go back to Excel and click on one of the OSAS imported fields. 

Select Data from the menu and choose Refresh Data
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General Ledger Balance Sheet

The spreadsheet is refreshed and the data is added, but the last account line does not have the 
calculated period 1 balances. The Current Year and Budget totals did not move down with the added 
data and do not reflect the correct amount.

The totals fields are not part of our original query so the refresh data option cannot affect those fields.

We need to modify the query properties to update the totals correctly. 

Click Undo to remove the account added through the refresh data function.

General Ledger Balance Sheet

To update the query properties, select an OSAS imported field, right mouse click and choose Data 
Range Properties or select the Data menu followed by Get External Data and then choose Data Range 
Properties.
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External Data Range Properties Box

To have Excel and Query update the calculated totals correctly, check the Fill down formulas in 
columns adjacent to data. Also uncheck the Adjust column width field and click OK.

General Ledger Balance Sheet

Refresh the data.

All rows should now have the correct calculated total and Totals Current Assets should now update 
and shift correctly.

Undo the refresh data to get the spreadsheet back to the original accounts.
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Next, change the format of columns H and I. 

General Ledger Balance Sheet

Highlight columns H and I

General Ledger Balance Sheet

Right mouse click and select Format Cells or select Format from the menu and choose Cells.
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Format Cells

The Format Cells box is displayed. Click the Number tab and choose Currency. Accept the default 
number of decimal places and select how you want negative numbers to display. Click OK to save.

Next, add the accounts for the Long Term Assets section to the sheet.

General Ledger Balance Sheet

Two rows below the Total Current Assets add a heading of Long Term Assets in column B (cell B20 
in this example). Format the cell.
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General Ledger Balance Sheet

Two rows below the Long Term Assets heading, click in Column A (Cell A22 in this example). Then 
select Data from the menu followed by Get External Data and New Database Query.

Choose Data Source

The Choose Data Source box is displayed. 

Select the same data source used in the first query. 

Select the OSAS 612 DATA source created earlier

Check the box for Use the Query Wizard to create/edit queries.
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Query Wizard – Choose Columns

The Query Wizard – Choose Columns box is displayed. 

Select the same fields used in the first query. 

For this spreadsheet, select the GLMA table in the Available tables and columns field. Choose the 
GL_ACCOUNT_NUM, DESCRIPTION, DB_MEMO_CR_SWITC, ACTUAL_BEGIN_BAL, 
ACTUAL_BAL_PD_1, BUDGET_BEGIN_BAL, and BUDGET_BAL_PD_1 columns.

Click the Next button.

Query Wizard – Filter Data

The Query Wizard – Filter Data box is displayed.

Select the GL Account field again, but this time for the is greater than or equal to account enter 
150000 and for the is less than or equal to enter 159999

Click the Next button
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Query Wizard – Sort Order

The Query Wizard – Sort Order box is displayed.

Do not sort this spreadsheet.

Click the Next button.

Query Wizard – Finish 

The Query Wizard – Finish box is displayed. 

Select where you want to put the data.

Select Return Data to Microsoft Excel and click the Finish button.
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External Data Range Properties

The Returning External Data to Microsoft Excel box is displayed. 

Select where to place the data in Excel. 

Click the Properties button. Uncheck the Include field names and Adjust column with fields, and 
check the Fill down formulas in columns adjacent to data.

Click OK and place the data in the select cell in Excel.

General Ledger Balance Sheet

The Long Term Asset accounts are displayed on the spreadsheet.
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Next create the Actual and Budget Period 1 totals

You can enter the formula for columns H and I the same as the Current Assets or you can copy the 
formula from the Current Assets area to save some time and steps. 

General Ledger Balance Sheet

Click any of the Current Year total fields in the Current Assets area. Right click and select Copy or 
select the Edit menu and choose Copy.

General Ledger Balance Sheet

Click in the first row in column H for the Long Term Assets section. Right click and select Paste 
Special or select the Edit menu and choose Paste Special.
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Paste Special

The Paste Special box is displayed. 

Under Paste select Formulas and click OK.

General Ledger Balance Sheet

The calculated total is displayed
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General Ledger Balance Sheet

Fill the remaining cells for column H in the Long Term Assets section.

General Ledger Balance Sheet

Repeat the process for Column I.
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General Ledger Balance Sheet

In column B create a Total Long Term Assets label and use the AutoSum function in Columns H and 
I to create the Long Term Assets subtotals.

Next, add the accounts for Other Assets.

Two rows below Total Long Term Assets enter a head of Other Assets in column B (cell B32 in this 
example) and format the cell any way you want.

To get the Other Asset accounts and totals, you can select the cell to start in, choose Get External 
Data and go through the Query Wizard as with the other queries or use the Copy/Paste functions and 
edit the query to get the same results.

General Ledger Balance Sheet

Click the first account in column A in the Long Term Assets section, hold the shift down and select 
the total for Budget Long Term Assets in column I. 

Right click and select Copy or select Copy from the Edit menu.
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General Ledger Balance Sheet

Select the cell where you want to start the Other Assets section, right click and select Paste or select 
Paste from the Edit menu.

General Ledger Balance Sheet

The data from the Long Term Assets section is copied into the Other Assets section. We must edit the 
query to get the information for the Other Asset accounts. Click in any OSAS field. 

Right mouse click and select Edit Query or Select Data from the menu then choose Get External 
Data, followed by Edit Query.



122

Microsoft Excel Using ODBC w/Excel

Query Wizard Warning

With the 2.3x and 3.0x versions of the BASIS ODBC Driver and Excel 2000 or higher, you will get a 
prompt saying “This query cannot be edited by the Query Wizard.”17 

Click the OK button.

Microsoft Query

This brings you into Microsoft Query, where you can edit the query and return the data to Excel.

17.With Excel 97 you are taken through the Query Wizard
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Microsoft Query

Select Remove All Criteria from the Criteria menu.

This will bring all of the records into the query.

Add Criteria

Select Criteria from the menu and choose Add Criteria. 

Leave Total blank

In Field select the GL_ACCOUNT_NUM column.

For Operator select “is greater than or equal to”.

For Value enter 180000 or click the Values button and select the value from a list.

Click the Add button.
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Add Criteria

After entering the first criteria field, select “is less than or equal to” in the Operator field.

In Value enter 189999 or click the Values button to select from a list.

Click the Add button.

Click the Close button to exit Add Criteria.18

Microsoft Query 

The query is updated with the new criteria.

18.With the Query Wizard in Excel 97, go to the Filter Data screen and change the account number for the 
first line to 180000 and change the second line to 189999.
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Microsoft Query

Select Return Data to Microsoft Excel from the File menu.19

You can save the query before returning the data to Excel if you would like.

General Ledger Balance Sheet

The spreadsheet is updated to show accounts 180000-189999. 

Change the Total Long Term Assets label to Total Other Assets.

19.With the Query Wizard in Excel 97, click the Next button to move to the Sort screen. Click the Next    
button on the Sort screen to move to the Finish screen. On the Finish screen select Return Data to Microsoft 
Excel. When the Returning External Data box is displayed, check the Properties to make sure they have not 
changed (See Page 110).
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General Ledger Balance Sheet

The next section of the spreadsheet will be the Liabilities and Equity. 

Two rows below the Total Other Assets enter Liabilities and Equity in column A (cell A39 in this 
example).

Select the Liabilities and Equity cell, cells B and C. Merge and center Liabilities and Equity in all 3 
cells. Make Bold or format any way you want.

Two rows below Liabilities and Equity in column B (cell B41 in this example) enter Liabilities and 
format any way you want.

Two rows below Liabilities in column B (cell B43 in this example) enter Current Liabilities and 
format any way you want.

General Ledger Balance Sheet

Copy the Other Assets account section, including the totals and Paste the cells in the Current 
Liabilities section. 
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Microsoft Query

Edit the query using Microsoft Query or the Query Wizard. Add the criteria for accounts 200000-
219999. 

Return the data to Excel

General Ledger Balance Sheet

The spreadsheet is updated with the Current Liabilities accounts. 

The Actual and Budget totals are displayed with the wrong sign. 

Liability accounts are normally credit accounts and carry a credit balance. In OSAS we store 
credit balances in credit accounts as a positive number. The formula used for the ending 
balance totals worked for Asset accounts because we wanted debit balances in debit accounts 
to print as positive numbers and credit balances in credit accounts to print as negatives. For Liability 
accounts we want the opposite to be true. In the OSAS statements function this was accomplished by 
using the Reverse Sign to Print function. We must modify the formula in Excel to do the same thing.
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General Ledger Balance Sheet

In the Asset account section we used the formula =SUM(Dn:En)*Cn for the Actual amounts and 
=SUM(Fn:Gn)*Cn for the Budget amounts with n representing the row number.

For the Liability accounts we could use the IF function and enter the formula 
=IF(Cn=1,SUM(Dn:En)*-1,SUM(Dn:En)) for the Actual amounts and =IF(Cn=1,SUM(Fn:Gn)*-
1,SUM(Fn:Gn)) for the Budget amounts. 

To remain consistent with the formula for the Asset accounts multiply the total by a -1 to get the same 
results as the IF formula. The formula for the Actual amounts would be: =(SUM(Dn:En)*Cn)*-1

For the first account under the Current Year column in the Current Liabilities section the formula 
would be =(SUM(D45:E45)*C45)*-1

General Ledger Balance Sheet

After getting the correct total in the first row, fill the remaining cells in the Actual column with 
the correct formula. The total should also change to reflect the correct sign.
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General Ledger Balance Sheet

The formula for the Budget amounts would be: =(SUM(Dn:En)*Cn)*-1

For the first account under the Budget column in the Current Liabilities section the formula would be 
=(SUM(F45:G45)*C45)*-1

General Ledger Balance Sheet

After getting the correct total in the first row, fill the remaining cells in the Budget column with the 
correct formula. The total should also change to reflect the correct sign.
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General Ledger Balance Sheet

Change the Total Other Assets label to Total Current Liabilities

General Ledger Balance Sheet

Two rows below Total Current Liabilities in Column B (cell B53 in this example) enter Long Term 
Liabilities and format the cell any way you want.
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General Ledger Balance Sheet

Copy the Current Liabilities account section, including the totals and Paste the cells in the Long Term 
Liabilities section.

Microsoft Query

Edit the query using Microsoft Query or the Query Wizard. Add the criteria for accounts 250000-
259999. 

Return the data to Excel
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General Ledger Balance Sheet

Change the Total Current Liabilities label to Total Long Term Liabilities

General Ledger Balance Sheet

Next, create a subtotal for all Liability accounts. 

Two rows below Total Long Term Liabilities in column B (Cell B72 in this example) enter Total 
Liabilities and format the cell. 

In column H (cell H72 in this example) create a subtotal for all Current Year Liabilities by adding the 
Total Current Liabilities and Total Long Term Liabilities. 

Enter the formula =SUM(H70,H61)

Press Enter to display the total and format the cell.
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General Ledger Balance Sheet

To get the Total Liabilities for the Budget column, repeat the steps for Column H in column I or click 
and drag the formula from H to I. 

General Ledger Balance Sheet

After adding the Total Liabilities row, we realize we did not add a row for the Total Assets. 

Insert two rows below the Total Other Assets 
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General Ledger Balance Sheet

In column B (cell B39 in this example) enter Total Assets and format the cell.

In Column H (cell H39) enter a formula to add the Total Current Assets, Total Long Term Assets and 
Total Other Assets. 

Enter the following formula: =SUM(H37,H30,H18)

Press Enter to display the total. 

General Ledger Balance Sheet

Repeat the process for Column I (cell I39) or click and drag the formula from column H to Column I.
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General Ledger Balance Sheet

We added 2 rows to the spreadsheet. If we check any of the totals below the added rows, we should 
see that the formula has changed to reflect the changes made above.

General Ledger Balance Sheet

The last section of this balance sheet is the Stockholders Equity. The accounts for this range are 
300000-999997. For accounts 300000-399999 we want to show all the detail and for accounts 
400000-999997 we only want to see the subtotal labeled as Net Profit.

First, two rows below the Total Liabilities in column B (Cell B76 in this example), enter 
Stockholders Equity and format the cells.

Copy the Long Term Liabilities section, but do not include the totals. Paste the section two rows 
below the Stockholders Equity in column A (Cell A78).
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Microsoft Query

Edit the query using Microsoft Query or the Query Wizard. Change the criteria to “greater than or 
equal to” 3000000 and “less than or equal to” 399999. 

Return the data to Excel 

General Ledger Balance Sheet
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General Ledger Balance Sheet

Select the first blank cell in Column B (cell B83 in this example) and enter Net Profit.

General Ledger Balance Sheet

Accounts 400000-999997 make up the Net Profit section but on the balance sheet we only want to 
display the subtotal for that account range, and not all the details. To do this we will create a query for 
that range on a different sheet and link to the total from the balance sheet.

Click the Sheet2 tab.
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General Ledger Balance Sheet

From the Data menu select Get External Data followed by New Database Query20.

Choose Data Source

The Choose Data Source box is displayed. 

Select the OSAS 612 DATA source created earlier

Check the box for Use the Query Wizard to create/edit queries.

20.With Excel 97 select Get External Data followed by Create New query. With Excel 2002 select Import 
External Data followed by New Database Query.
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Query Wizard – Choose Columns

The Query Wizard – Choose Columns box is displayed. 

Select the tables (files) and columns (fields) for the query. 

Select the same fields from the GLMA table. Choose the GL_ACCOUNT_NUM, 
DESCRIPTION, DB_MEMO_CR_SWITC, ACTUAL_BEGIN_BAL, ACTUAL_BAL_PD_1, 
BUDGET_BEGIN_BAL, and BUDGET_BAL_PD_1 columns.

Click the Next button.

Query Wizard – Filter Data

The Query Wizard – Filter Data box is displayed.

For this filter select “is greater than or equal to” 400000 And “is less than or equal to” 999700.

Click the Next button
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Query Wizard – Sort Order

The Query Wizard – Sort Order box is displayed.

Select the order to sort the rows by. 

Do not sort this spreadsheet.

Click the Next button.

Query Wizard – Finish 

The Query Wizard – Finish box is displayed. 

Select where you want to put the data.

Select Return Data to Microsoft Excel and click the Finish button.
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Returning External Data to Microsoft Excel

The Returning External Data to Microsoft Excel box is displayed. 

Select where to place the data in Excel. 

For this spreadsheet, click the Properties button.

External Data Range Properties

The External Data Range Properties box is displayed. 

Check Fill down formulas in columns adjacent to data. Click the OK button.

The Returning External Data to Microsoft Excel box is re-displayed. 

The cell selected when we chose Get External Data should be displayed in the Existing worksheet 
field. Click OK.



142

Microsoft Excel Using ODBC w/Excel

General Ledger Balance Sheet

The data is imported with column headings. 

Create the Current Year column heading and enter a formula for the Actual End Balance for Period 1 
using the Actual Beginning Balance, Actual Balance Period 1 and Debit/Memo/Credit Switch Fields.

The formula should be =(SUM(Dn:En)*Cn)*-1, just like the other Liability accounts. 

In cell H2 enter =(SUM(D2:E2)*C2)*-1

Press Enter to display the total.

General Ledger Balance Sheet

Fill the remaining cells in column H with the total.
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General Ledger Balance Sheet

Next, in Column I, enter a Budget heading and create the formula for the Budget Balance for Period 1 
using the Budget Beginning Balance, Budget Balance Period 1 and Debit\Memo\Credit Switch. 

In cell I2 enter =(SUM(F2:G2)*C2)*-1

Press Enter to display the total.

General Ledger Balance Sheet

Fill the remaining cells in column I with the total.
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General Ledger Balance Sheet

Next, we will hide columns C, D, E, F and G.

Click and highlight Columns C through G. 

Right click and select Hide or select Window from the menu and choose Hide.

General Ledger Balance Sheet

Next, create a subtotal using the Sum or AutoSum functions, for the Net Profit amount for the 
Current Year and Budget columns. You can also create a Net Profit label.
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General Ledger Balance Sheet

Optionally, create a range name for the Current Year and Budget totals. 

Click the Current Year total and select Insert from the menu followed by Name and choose Define.

Define Range Name

Enter a name without spaces and click the Add button.

Repeat the same steps for the Budget total

After both names are entered, click Close.
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General Ledger Balance Sheet

Next, link the Current Year and Budget Net Profit totals from the Balance sheet to the Net Profit 
fields on Sheet2. 

Go back to the balance sheet. Select the cell in Column H next to the Net Profit label (cell H83 in this 
example).

General Ledger Balance Sheet

Type = in the cell. 
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General Ledger Balance Sheet

Click the Sheet2 tab and select the Current Year Net Profit total.

Press Enter

General Ledger Balance Sheet

The Current Year Net Profit amount should display on the Balance sheet.
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Repeat the steps to get the Net Profit Budget amount on the Balance sheet.

General Ledger Balance Sheet

Select the cell in Column I next to the Net Profit label (cell I83 in this example).

General Ledger Balance Sheet

Type = in the cell. 
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General Ledger Balance Sheet

Click the Sheet2 tab and select the Budget Net Profit total.

Press Enter

General Ledger Balance Sheet

The Budget Net Profit amount should display on the Balance sheet.
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General Ledger Balance Sheet

Create a label and totals for the Current Year and Budget columns in the Stockholders Equity section.

General Ledger Balance Sheet

Create a total for Current Year Liabilities and Equity by adding the Total Liability to the Total 
Stockholders Equity OR by adding the Total Current Liabilities, Total Long Term Liabilities and 
Total Stockholders Equity subtotals together.
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General Ledger Balance Sheet

Repeat the steps for the Budget Column and format the cells to match the other totals.

General Ledger Balance Sheet

Click and highlight columns C through G.

Right click and select Hide or select Window from the menu followed by Hide.
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General Ledger Balance Sheet

Only the Acct No, Description, Current Year, and Budget columns should display.

The next step is to test the Refresh option by adding a few accounts in OSAS GL to verify the 
subtotals and rows are updated correctly.

GL Accounts

We already added an account to the 100000-109999 range. 

Add an account to the 150000-159999 range.
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GL Accounts

Add an account to the 180000-189999 range.

GL Accounts

Add an account to the 3000000-399999 range.
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GL Accounts

Add an account to the 400000-999700 range, which is on Sheet2 in the workbook

General Ledger Balance Sheet

Go back to the Balance sheet in Excel select an OSAS field in the Current Assets section and Refresh 
the Data.

The account added to the Current Assets range is added to the sheet and the totals are updated 
accordingly, but the accounts added to the other ranges are not added to the sheet. The Net Profit 
amount on Sheet2 is not update as well.

The Refresh Data option only refreshes data in the selected query. 

This balance sheet has a total of 7 queries including the Net Profit query on Sheet2.

To refresh each query we could select each one and use the Refresh Data option, but that can be time 
consuming.
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General Ledger Balance Sheet

To refresh several queries at one time in Excel use the Refresh All option on the External Data 
Source Toolbar.

From the View menu, select Toolbars followed by External.

General Ledger Balance Sheet

The External Data Source tool bar is displayed.

Make sure the cursor is in a field brought in with a query and select Refresh All from the tool bar.
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General Ledger Balance Sheet

All queries in the workbook are refreshed at one time. 

General Ledger Balance Sheet
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The last step is to print the Balance Sheet.

General Ledger Balance Sheet

Select Print Preview from the File menu.

General Ledger Balance Sheet

The second page does not have the column headings displayed and the page break is not after the 
Total Assets row, so the Current Liabilities are split on two pages.
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General Ledger Balance Sheet

To make the column headings print on all pages, from the File menu select Page Setup.

Page Setup

Click the Sheet tab.

In the Rows to repeat at top field enter row 1 or click the graphic button at the end of the field.
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Page Setup

Click the row you want to repeat and Excel will fill in the field for you.

General Ledger Balance Sheet
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General Ledger Balance Sheet

The column headings now print on all pages.

Next, edit the sheet to print Assets on one page and Liabilities on the next page.

General Ledger Balance Sheet

Select the row below Total Assets.

From the Insert menu, select Page Break



Microsoft ExcelUsing ODBC w/Excel

161

General Ledger Balance Sheet

Now the Assets print on page 1 and the Liabilities print on page 2.

General Ledger Balance Sheet
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The last step for this spreadsheet is to create a Header for all the pages.

General Ledger Balance Sheet

From the View menu select Header and Footer or from the File menu select Page Setup and select the 
Header/Footer tab.

Page Setup

To create a header, click the Customer Header button.
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Custom Header

Enter the header information you want. You can enter information in the Left, Center and Right 
Sections and use some of the predefined headers from Excel.

For this sheet, click the Date and Time fields for the Left section. In the Center section enter Builders 
Supply on one line and Balance Sheet with Budget Comparison on the next line. In the Right section, 
enter Page and click the Page Number field.

Click OK to save the header.

Page Setup

The Page Setup is re-displayed, showing the customized header. 

Click OK to save the Page Setup
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General Ledger Balance Sheet

Reprint the spreadsheet.

General Ledger Balance Sheet
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Build Shadow Dictionary

If you are using version 1.1 of the Basis ODBC Drivers, (OSAS version 6.02 or earlier) you must run 
the Build Shadow Dictionary function to access the OSAS data. 

A shadow dictionary is a streamlined copy of the main data dictionary that is used by the ODBC 
driver to access the data in the data files. The shadow dictionary is used because it is more efficient 
for data retrieval than the main dictionary.

Creating a shadow dictionary allows faster access to your data when you use the driver. Once you 
have created the shadow dictionary, you can check the “Fast Connect” and “No Shadow 
Dictionary Consistency Check” options in the ODBC driver setup to allow the faster access.

Use the Build Shadow Dictionary function to create the shadow dictionary, and to update the shadow 
dictionary after changes are made to the main data dictionary

Dictionary Tools Menu

A
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Build Shadow Dictionary

Build Shadow Dictionary Screen

To create the shadow dictionaries perform the following: 

Select Build Shadow Dictionary from the Dictionary Tools menu.

The first time you run the Build Shadow Dictionary function, the Proceed command, PgDn or Esc P, 
is displayed to create the shadow dictionaries.

There is also a reminder  – Make sure you options for ‘Fast Connect’ and ‘No Shadow Dictionary 
Consistency Check’ are checked in the Advanced settings of your BASIS ODBC Driver.18

The system creates a shadow dictionary for all OSAS data dictionaries installed, and for any files, 
fields or indexes added through those functions.

18. The Fast Connect and No Shadow Dictionary Consistency Check options are selected when you create a 
data source using the BASIS ODBC Driver version 1.1. This function is not done through OSAS.
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Re-create Shadow Dictionary Screen

If the shadow dictionaries have already been created you are prompted, “Shadow dictionary already 
exists. Do you want to re-create it?”

Select, Y, for Yes, if you want to overwrite the old set of shadow dictionaries and create a new set. 

Select N, for No, if you do not want to rebuild the shadow dictionaries

Note

You only need to run the Build Shadow Dictionary function once, unless an application is installed 
after the shadow dictionaries have been created19or if you create or edit files, fields or indexes after 
the shadow dictionaries have been created.

19. In version 5.2 the ODBC Kit must also be reinstalled if you add an application after the shadow dictio-
naries have been built.
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Build Shadow Dictionary
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Unix/LINUX CONFIG.TPM File

If your OSAS data is stored on a UNIX or LINUX system, you cannot use the Edit CONFIG.TPM 
function in OSAS to create a configuration file, unless you are using a data server. 

UNIX and LINUX do not use drive letters or colons for paths but the BASIS ODBC Driver needs a 
drive letter and colon for the DICTIONARY, DATA and SYSFIL paths.

Edit CONFIG.TPM Selection Screen UNIX System

This configuration file can cause errors when trying to link to the OSAS files.

B
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Unix/LINUX CONFIG.TPM File

To prevent this problem you must first use NFS software on the Windows machines where the BASIS 
ODBC Drivers are installed. NFS software allows you to map the UNIX or LINUX volume as a 
regular Windows/Dos drive. 

Once the drives are mapped use any text edit to create the configuration file20. 

The file should have a minimum of four lines. 

Line one should contain the DICTIONARY variable and the path using the NFS mapped drive to 
point the directory containing the data dictionaries. 

Line two should contain the DATA variable and the path using the NFS mapped drive to point to the 
directory containing the OSAS data you want to access with this configuration file. 

Line three should contain the CID variable and the company ID for the data files you want to 
access.21

Line four should contain the SYSFIL variable and the path using the NFS mapped drive to point to 
the sysfil directory in OSAS. The sysfil directory contains some Resource Manager data files.

The following example uses N as the NFS mapped drive. The configuration file should look like this:

DICTIONARY=N:/OSAS/RWDATA/
DATA=N:/OSAS/DATA/
CID=H
SYSFIL=N:/OSAS/SYSFIL

Save the file and store it anywhere on the Windows machine

Note

If you use DATA2 or DATA 3 or have any other variables, such as last year PA or GL files, add those 
to the configuration file also.

20. The configuration file does not have to have the name CONFIG.TPM. The file is an 8.3 Dos file and is 
only required to have the TPM extension, but can have any name you want.
21. If you have multiple companies, you must create a configuration file for each company.
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There are some security issues with ODBC because there are no options in OSAS to prevent someone 
from having access to certain files. All the data dictionaries are installed in the same files and you 
cannot limit the access to those data dictionaries by application. So, if you have someone locked out 
of an application in OSAS, like Payroll or General Ledger, they will be able to access those data files 
in a third party product, such as Excel or Access using the ODBC Drivers and with the Read/Writer 
drivers they could even change the data files. 

To prevent unauthorized people from accessing certain data files you have to create a second set of 
data dictionaries, and store the second set in a secure directory network that has limited access on the 
network or store the second set of data dictionaries to your local drive. 

In the original set of data dictionaries, only include the files you want everyone to access. In the 
second set of data dictionary files, only include the files you want secured.

To create a secure set of data dictionary files perform the following steps:

This example uses the Payroll files but the steps will be the same for any application you want 
secured.

1. At the operating system level copy the *.OSI files from the SYSFIL22 directory to the RWdata 
directory.

2. Erase the DD_*.OSI files that were copied to the RWdata directory. 

3. Rename the remaining copied *.OSI files to a different extension other then OSI. 

Note

The extension used in the rename does not matter because the files have to be renamed to have a .1 
extension when you move them to the secure directory23.

Note

 DO NOT rename the files to .1 while they are in the RWdata directory or you risk overwriting 
the original .1 data dictionary files

Example: Rename the copied *.OSI files to *.PA if you are creating Payroll data dictionary files.

22. In 5.2 the *.OSI files are in the progRM directory.
23. The ODBC Drivers will only work with data dictionary files that have a .1 extension.

C
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ODBC Security

Copy File(s) To Dictionary

4. In OSAS, Select Copy File(s) to Dictionary from the Dictionary Tools menu. This will allow 
you to copy the data dictionary files from the main dictionary to the new dictionary.

5. Enter the following:

This will copy all the selected application files, fields and indexes from the *.1 data dictionary files to 
the *.PA (or to the extension you used for the copied files).

If you are using the 2.3 or 3.0 version of the ODBC drivers (OSAS 6.05 or higher) skip to step 8. 

If you are using the 1.1 version of the ODBC drivers (OSAS 5.2 or 6.02) proceed to step 6.

Field Description

From Dictionary Enter the extension of the source data dictionary files. This is usually 1 to 
copy the .1 data dictionary files.

The Inquiry command, F2 or Esc W, is available to select the source files.

To Dictionary Enter the extension of the destination data dictionary files. This will be the 
extension you used to rename the copied *.OSI files. 

The Inquiry command, F2 or Esc W, is available to select the destination 
files.

PA in this example.

Copy: Select 1, for All Application File, to copy the data dictionary files for a 
specific application.

Application ID Enter the id for the application whose data dictionary files you want to copy.

The Inquiry command, F2 or Esc W, is available to select the application to 
copy.

PA in this example
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Data Dictionary Select Screen

6. Once the files have been copied, use the F9 from any ODBC menu to switch the copied data 
dictionary files. 

You can use the Inquiry command, F2 or Esc W, to select the data dictionary files you want to 
access.

You can check in Files or Fields to verify that you have switched to the correct set of data dictionary 
files.

PA Data Dictionary Files Screen

Field Description

Dictionary Displays the current set of data dictionary files in use on the current terminal.
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ODBC Security

7. Once you have switched to the new data dictionary files run the Build Shadow Dictionary 
functions from the Dictionary Tools menu.

This will build files for the current set of data dictionary files in use on the current terminal.You 
may be prompted: Shadow dictionary already exist. Do you want to re-create it? Select Y, for 
Yes.

8. At the operating system level move the 13-copied data dictionary files24 (*.PA in this example) 
from the RWdata directory to the secured subdirectory or your local drive.

Note

If you use a directory on the network, DO NOT use any directories listed in the Directories function 
in Resource Manager or any directories listed in Application Information in Resource Manager. 
Anyone will be able to access this new set of data dictionary files through OSAS, if they are moved 
to either of those locations. 

You can create a different subdirectory under your OSAS directory for the second set of data 
dictionary files, such as RWdata2. This will not be listed in the Directories function or 
Application Information so no one will have access to the data dictionary files through OSAS.

9. In the secured subdirectory, rename the 13 new data dictionary files to have a .1 extension25 

Edit CONFIG.TPM Screen

10. Select Edit CONFIG.TPM from the ODBC Kit menu to create a new configuration file.

Edit the Dictionary variable to point to the drive and directory where you copied the new data 
dictionaries. 

11. Copy the configuration file to the secure directory or your local hard drive.

24. If you are using the 1.1 ODBC drivers move the DD_*.DAT files as well.
25. The ODBC Drivers will only work with files that have a .1 extension. DO NOT rename the DD_*.DAT 
files.
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Data Dictionary Select Screen

12. Use the F9 and switch back to the .1 Data Dictionaries.

Main Data Dictionary Files Screen – Deleting Files

13. Select Files from the Dictionary Tools menu and delete the data dictionary files that you do not 
want to give everyone access, using the Delete command, F3 or Esc D.

In this example, delete the Payroll data dictionary files.

If you are using the 2.3 or 3.0 ODBC drivers, you are done26. 

If you are using the 1.1 ODBC drivers, proceed to step 14.

26. To edit these data dictionary files you will have to copy or move them back to the RWdata, ProgRm or 
ProgOD directories. 
These data dictionary files have the same name and extension as the main data dictionary files, so you must 
rename them before you copy them to insure you do not overwrite your main data dictionary files. 

Use the F9 to switch between the data dictionaries.
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Build Shadow Dictionary Screen

14. Select the Build Shadow Dictionary function from the Dictionary Tools menu, to re-create the 
shadow dictionary files for the edited set of main dictionary files27

27. To edit these data dictionary files you will have to copy or move them back to the RWdata, ProgRm or 
ProgOD directories. 

Since these data dictionaries have the same file name and extension as the main data dictionaries, rename 
them before you copy them to insure you do not overwrite your main data dictionaries. 

Use the F9 to switch between the data dictionaries. If you make any changes you will have to re run the 
Build Shadow Dictionary function and copy the new DD_*.DAT files and the second set of data dictionaries 
back to the secured directory. Rename them back to *.1. Use the F9 to switch back to the original*.1 dictio-
naries and run the Build Shadow Dictionary function again.
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Use the following steps to access last year Payroll or previous year General Ledger data with ODBC. 
These steps will work with the 3.0, 2.3 or the 1.1 Basis ODBC Drivers.

You will need to create a separate configuration file for last year Payroll and current year Payroll and 
a separate configuration file for each GL Year you want to access.

Create a configuration file with the Edit CONFIG.TPM function in ODBC Kit.

Edit CONFIG.TPM

D
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Payroll Variable for Last Year Files

Use the Append function to add Variables for last year Payroll.

Append Field Information – PLY Variable

This variable will access Payroll files that have a LY extension 

Use the Proceed command, PgDn or Esc P, to save the variable.

Field Description

Variable Enter the name of the variable you want to add. The variable name can be 
anything you want. 

This variable will be added to the ODBC Path field in Files, which will 
allow you to access the data you want.

If you are using 6.1x the variable for last year payroll has already been 
added to the data dictionary file. Add that variable to the configuration file 
to access last year’s payroll with ODBC. The variable used is PLY, but 
you can use any variable name you want. If you use a different variable 
name, you will have to change each file to match the new variable name.

If you are using 6.05 or lower, you must add the variable name used to 
each file with the Files function on the Dictionary Tools menu. You can 
use the same PLY variable name or create a different one.

Data Enter the extension of the data file in OSAS that you want to access with 
the ODBC drivers.

For Last Year Payroll files enter “.LY” (without the quotes)
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General Ledger Variable for Previous Year Files

You can add the General Ledger Variable for pervious years to the same configuration file as the 
Payroll Variable or you can create a new configuration file for the GL variable.

Use the Append function to add Variables for the General Ledger year you want to access.

Append Field Information – GLY Variable

This variable will access General Ledger files that have a Y99 extension28.

Use the Proceed command, PgDn or Esc P, to save the variable.

Field Description

Variable Enter the name of the variable you want to add. The variable name can be 
anything you want. 

This variable will be added to the ODBC Path field in Files, which will 
allow you to access the data you want.

If you are using 6.1x, the variable for pervious year general ledger files 
has already been added to the data dictionary file. Add that variable to the 
configuration file to access last year’s payroll with ODBC. The variable 
used is GLY, but you can use any variable name you want. If you use a 
different variable name, you will have to change each file to match the 
new variable name.

If you are using 6.05 or lower, you must add the variable name used to 
each file with the Files function on the Dictionary Tools menu. You can 
use the same GLY variable name or create a different one.

Data Enter the extension of the data file in OSAS that you want to access with 
the ODBC drivers.

For Previous Year GL files enter “.Yxx” (without the quotes), where xx 
represents the GL Year you want to access.

This example uses Y99.

28. Each GL Year will require a separate configuration file.
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The TPM file should look something like the following.

TPM File

Select Write to save the changes to the configuration file.

Next, create a configuration file to access current year data.

Create a configuration file with the Edit CONFIG.TPM function in ODBC Kit.
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Payroll Variable for Current Year Files

Use the Append function to add Variables for current year Payroll.

Append Field Information – PLY Variable

This variable will access Payroll files that do not have an extension, which is how OSAS stores the 
current year files.

Use the Proceed command, PgDn or Esc P, to save the variable.

Field Description

Variable Enter the same name you used for the last year Payroll variable.

If you are using 6.1x the variable for last year payroll has already been added to 
the data dictionary file. Add that variable to the configuration file to access last 
year’s payroll with ODBC. The variable used is PLY, but you can use any variable 
name you want. If you use a different variable name, you will have to change each 
file to match the new variable name.

If you are using 6.05 or lower, you must add the variable name used to each file 
with the Files function on the Dictionary Tools menu. You can use the same PLY 
variable name or create a different one.

Data1

1.The configuration file for last year data contained a .LY in the data field. This means 
ODBC will look for a file with a LY extension, after the variable is added end of the file in 
Dictionary Tools. The last year configuration file will only access the last year files. If the 
files are not available, you will get Fserr=13 in Excel (same as and error 12, missing or dupli-
cate file) or you will get an error message in Access “Query must have at least one destina-
tion field”.

You MUST create another configuration file to access current year data, using the same vari-
able name but leaving the data field blank. ODBC will look for a file without an extension. If 
the files are not available you will get Fserr=13 in Excel, or and error message in Access 
“Query must have at least one destination field”

Leave this field blank. 

OSAS stores the current year Payroll files without an extension. 
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General Ledger Variable for Current Year Files

You can add the General Ledger Variable for current year to the same configuration file as the Payroll 
Variable or you can create a new configuration file for the GL variable.

Use the Append function to add Variables for the General Ledger year you want to access.

Append Field Information – GLY Variable

This variable will access General Ledger files that do not have an extension, which is how OSAS 
stores the current year files.

Use the Proceed command, PgDn or Esc P, to save the variable.

Field Description

Variable Enter the same name you used for the previous year General Ledger variable.

If you are using 6.1x, the variable for previous year general ledger files has 
already been added to the data dictionary file. Add that variable to the 
configuration file to access last year’s payroll with ODBC. The variable used is 
GLY, but you can use any variable name you want. If you use a different 
variable name, you will have to change each file to match the new variable 
name.

If you are using 6.05 or lower, you must add the variable name used to each file 
with the Files function on the Dictionary Tools menu. You can use the same 
GLY variable name or create a different one.

Data13

1.3 The configuration file for previous year data contained a .Yxx (xx represents the GL year) 
in the data field. This means ODBC will look for a file with a Yxx extension, after the vari-
able is added end of the file in Dictionary Tools. The previous year configuration file will 
only access the files for the year entered in the data field. If the files are not available, you 
will get Fserr=13 in Excel (same as and error 12, missing or duplicate file) or you will get an 
error message in Access “Query must have at least one destination field”.

You MUST create another configuration file to access current year data, using the same vari-
able name but leaving the data field blank. ODBC will look for a file without an extension. If 
the files are not available you will get Fserr=13 in Excel, or and error message in Access 
“Query must have at least one destination field”

Leave this field blank. 

OSAS stores the current year GL files without an extension. 
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The TPM file should look something like the following.

TPM File

Select Write to save the changes.
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Adding the Variables to Dictionary Files

If you are using 6.1x the PLY and GLY variables have already been added to the data dictionary files. 
If you are using 6.05 or earlier you will have to add the variables to each data dictionary file. 

Select Files from the Dictionary Tools menu in the ODBC Kit.

Dictionary Tools Menu - Files

Select the file you want to add the variable to and press Enter to edit the file. 

Files
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Edit Files

Add the Payroll variable within parentheses to the ODBC Path field. 

You will have to add this variable to each Payroll file that you want to access last year or this year 
data. 

Repeat the same steps for the General Ledger files.

Files
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Edit Files

Add the General Ledger variable to all the GL files you want to access pervious year information. 

You will have to add this variable to each General Ledger file that you want to access previous year 
or this year data.

If you are using 6.05 or higher, you are now ready to access last year or current year data with ODBC

If you are using 5.2229- 6.02, you will have to run the Build Shadow Dictionary function to recreate 
the shadow dictionary to access last year or current year data with ODBC. 

You will need to create a separate data source file, for each configuration file, using the Basis ODBC 
Driver. 

One data source will access last year Payroll and previous year General Ledger files. The other data 
source will access current year Payroll and General Ledger files. 

If you have more GL years you want to access, you must create a configuration file for each year and 
data source for each year..

29.For 5.22 you MUST have the latest 5.21A installed.
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Basis ODBC 3.0 and 2.3 Drivers

Using Excel/Query to create the data source

Get External Data – New Database Query Screen

Start Excel. From the Data menu select Get External Data followed by New Database Query30.

30. With Excel 97 select Get External Data followed by Create New query. With Excel 2002 select Import 
External Data followed by New Database Query.

E
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Choose Data Source Screen

The Choose Data Source screen is displayed. 

Select the data source you want to use for this query or choose <New Data Source> if the one you 
want to use is not listed.

Highlight <New Data Source> and select the OK button.

Create New Data Source Screen - Step 1

The Create New Data Source screen is displayed. 

There are four steps in creating a data source.

1. Enter a name for the data source you are creating. The data source name can be anything you 
like.

Note

Enter a name that is easy for you to identify which company’s information you are accessing.
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Create New Data Source Screen - Step 2 and 3

2. Select the driver for the database you want to access. 

For the OSAS data files, select the BASIS ODBC Driver31.

3. Connect to the data source configuration file. 

Click the Connect button. 

31. If you are using the 1.1 version of the ODBC Drivers, select BASIS ODBC Driver 32-Bit.
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BASIS ODBC Driver Data Source Configuration Screen

The BASIS ODBC Driver Data Source Configuration screen is displayed. 

Enter the following:

Field Description

Data Source Name This field is unavailable with Excel and Query data sources. 

Description This field is unavailable with Excel and Query data sources.

Database Enter the path and filename of the configuration file you created with 
the Edit CONFIG.TPM function.

Use the Browse button to search for the file. The default location is the 
RWdata directory in OSAS.

User ID If you are using a data server with OSAS, you must enter a valid 
network user ID to use with this data source file. If you do not enter a 
valid user ID, you will not be able to access your OSAS data stored on 
the data server. 

Root, Admin, Supervisor, and Administrator are not allowed.

Authentication Click this button for secure data servers that require user 
authentication. You can enter a User ID, Password and Domain, to 
authenticate the user logging in, or an Authentication String.

Read Timeout Enter a number between 0 and 255 to indicate the number of seconds to 
wait for a locked record to become available. The default is 10.
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BASIS ODBC Driver Data Source Configuration Screen

Option Description

Read Only Access Check this box if you are using the Read/Write version of the ODBC 
Drivers and you want this data source to allow read only access. Any 
changes made to the files are not allowed with read only access.

Disable Use of Math 
Coprocessor

Check this box, if you want to disable the use of the math 
coprocessor. 

On machines with math coprocessors, the ODBC Drivers may be able 
to use the coprocessor to enhance the speed and accuracy of the 
functions.

Enable Floating Network 
Lock Byte

Check this box to enable the older, slower file-locking scheme, which 
allows for standard access across the network.

No Strict Key Checking 
on CREATE TABLE

Check this box, if no primary key has been specified in the data files, 
creates a primary key using as many columns (fields) as can fit into 
the 120 character maximum key length. If this option is not select, 
then a primary key must be setup in each data file or errors will occur.

Pack numerics over 14 
digits long

Check this box, if you have numeric values that are more then 14 
digits to allow compression of these values into a pseudo-binary form 
to preserve disk space.
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BASIS ODBC Driver Data Source Setup Screen 

Option Description

Force File Length Update 
on Fat Systems

Check this box to force MS-DOS to update the length of a dynamic file 
after any changes are made to the file.

Allow Multiple Reads in 
a Record

Check this box to allow multiple read processes to access the key of a 
keyed file.

14 Digit Business Math Check this box to put the ODBC Drivers in a 14 digit Business Math 
mode. This forces keys and templates to use 14 digit Business Math 
precision.

Do Not Automatically 
Reorder Tables

The ODBC drivers may attempt to reorder the table if you are using a 
Select statement against multiple files, for optimization. Check this 
box, if you do not want the ODBC drivers to try to reorder the table. 

Pad variable length 
columns with spaces

Check this option if you are using the Read/Write version of the ODBC 
Drivers, so that any updates you make to the OSAS files will be 
padded correctly.
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BASIS ODBC Driver Data Source Setup Screen 

Logging Field Description

Log Error Messages Check this option to write any error messages generated by the ODBC 
Drivers to the log file entered in the Log File Location field.

Log Function Calls Check this option1to write each ODBC API function call to the log file 
entered in the Log File Location field.

Log File Access for 
Query Optimization

Check this option to write each file system read to the log file entered 
in the Log File Location field.

Log File Location Enter the path and filename for the log file. This file is used by the Log 
Error Messages, Log Function Calls, and Log File Access for Query 
Optimization options.
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BASIS ODBC Driver Data Source Setup Screen 

Select the OK button to save the data source setup.

Dates Field Description

Column Suffix(es) Enter the suffix(es) of the columns that are to be converted to the OEM 
date type selected in the OEM Type field.

More then one suffix can be entered. If more then one suffix is entered 
separate each with a comma. 

OEM Types By default, the numeric columns that end in the Date Column Suffix 
are treated as Julian Numbers and converted to SQL Dates. 

If you are using an OEM database that uses non-Julian numbers for the 
data format, select one of the OEM data types listed in the combo box 
to indicate your OEM date preference for columns ending in the Date 
Column Suffix.

Translation Click this button to select the Microsoft Code Page Translator or other 
ODBC character translator.

Character Set Translation The translator selected, if any, with the translation button is displayed.
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Create New Data Source – Step 4

The Create New Data Screen is re-displayed. 

4. Select an optional table for your data source. This table is selected by default, whenever you use 
this data source, but you can always select any table available.

You can also save your user ID and password with this data source.

Click OK when finished.

Choose Data Source Screen

The Choose Data Source screen is re-displayed.

Place a check in the Use the Query Wizard to create/edit queries field, highlight the data source 
created and click OK.
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Using the ODBC Administrator to create the data source

ODBC Data Source Administrator

Create a Data Source with the 32-bit ODBC Administrator in the control panel.

Select File DSN for use with Excel and Query

Click the Add button to create the new data source.

Option Description

User DSN Creates a data source for this machine that only the user creating it can 
access.

System DSN Creates a data source for this machine that anyone who uses this machine 
can access.

File DSN Creates a data source that can be shared by users who have the same 
drivers installed.

Drivers Displays the list of installed ODBC Drivers.

Tracing Creates a log file of calls made to the ODBC Drivers. This can be used to 
aid support and debug your applications.

Connection Pooling Allows applications to reuse open connection handles, which saves round-
trips to the server.
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Create New Data Source

The Create New Data Source screen is displayed select the Basis ODBC Driver.

Select the Next button.

Create New Data Source

Enter a name for the data source or browse to an existing data source.

Click the Next button.
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Creating a Data Source

Create New Data Source

The last screen displays summary information about the type of data source, name and driver used to 
create the data source.

Click the Finished button if everything is correct. 

Click the Back button if you need to edit any of the displayed information.
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BASIS ODBC Driver Data Source Configuration Screen

The BASIS ODBC Driver Data Source Configuration screen is displayed. 

Enter information for the following fields:

Field Description

Data Source Name This field is unavailable with Excel and Query data sources. 

Description This field is unavailable with Excel and Query data sources.

Database Enter the path and filename of the configuration file you created with 
the Edit CONFIG.TPM function.

Use the Browse button to search for the file. The default location is the 
RWdata directory in OSAS.

User ID If you are using a data server with OSAS, you must enter a valid 
network user ID to use with this data source file. If you do not enter a 
valid user ID, you will not be able to access your OSAS data stored on 
the data server. 

Root, Admin, Supervisor, and Administrator are not allowed.

Authentication Click this button for secure data servers that require user 
authentication. You can enter a User ID, Password and Domain, to 
authenticate the user logging in, or an Authentication String.

Read Timeout Enter a number between 0 and 255 to indicate the number of seconds to 
wait for a locked record to become available. The default is 10.
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Option Description

Read Only Access Check this box if you are using the Read/Write version of the ODBC 
Drivers and you want this data source to allow read only access. Any 
changes made to the files are not allowed with read only access.

Disable Use of Math 
Coprocessor

Check this box, if you want to disable the use of the math coprocessor. 

On machines with math coprocessors, the ODBC Drivers may be able 
to use the coprocessor to enhance the speed and accuracy of the 
functions.

Enable Floating Network 
Lock Byte

Check this box to enable the older, slower file-locking scheme, which 
allows for standard access across the network.

No Strict Key Checking 
on CREATE TABLE

Check this box, if no primary key has been specified in the data files, 
creates a primary key using as many columns (fields) as can fit into the 
120 character maximum key length. If this option is not select, then a 
primary key must be setup in each data file or errors will occur.

Pack numerics over 14 
digits long

Check this box, if you have numeric values that are more then 14 digits 
to allow compression of these values into a pseudo-binary form to 
preserve disk space.

Force File Length Update 
on Fat Systems

Check this box to force MS-DOS to update the length of a dynamic file 
after any changes are made to the file.

Allow Multiple Reads in 
a Record

Check this box to allow multiple read processes to access the key of a 
keyed file.

14 Digit Business Math Check this box to put the ODBC Drivers in a 14 digit Business Math 
mode. This forces keys and templates to use 14 digit Business Math 
precision.

Do Not Automatically 
Reorder Tables

The ODBC drivers may attempt to reorder the table if you are using a 
Select statement against multiple files, for optimization. Check this 
box, if you do not want the ODBC drivers to try to reorder the table. 

Pad variable length 
columns with spaces

Check this option if you are using the Read/Write version of the ODBC 
Drivers, so that any updates you make to the OSAS files will be 
padded correctly.

Log Error Messages Check this option to write any error messages generated by the ODBC 
Drivers to the log file entered in the Log File Location field.

Log Function Calls Check this option1to write each ODBC API function call to the log file 
entered in the Log File Location field.

Log File Access for 
Query Optimization

Check this option to write each file system read to the log file entered 
in the Log File Location field.

Log File Location Enter the path and filename for the log file. This file is used by the Log 
Error Messages, Log Function Calls, and Log File Access for Query 
Optimization options.
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BASIS ODBC Driver Data Source Setup Screen

Select the OK button to save the data source setup.

Dates Field Description

Column Suffix(es) Enter the suffix(es) of the columns that are to be converted to the OEM 
date type selected in the OEM Type field.

More then one suffix can be entered. If more then one suffix is entered 
separate each with a comma. 

OEM Types By default, the numeric columns that end in the Date Column Suffix 
are treated as Julian Numbers and converted to SQL Dates. 

If you are using an OEM database that uses non-Julian numbers for the 
data format, select one of the OEM data types listed in the combo box 
to indicate your OEM date preference for columns ending in the Date 
Column Suffix.

Translation Click this button to select the Microsoft Code Page Translator or other 
ODBC character translator.

Character Set Translation The translator selected, if any, with the translation button is displayed.
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ODBC Data Source Administrator

The data source is listed in the ODBC Administrator Box. Click OK to exit.
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Basis ODBC 1.1 Drivers

Using Excel/Query to create the data source

Get External Data – New Database Query Screen

Start Excel. From the Data menu select Get External Data followed by New Database Query32.

Choose Data Source Screen

The Choose Data Source screen is displayed. 

Select the data source you want to use for this query or choose <New Data Source> if the one you 
want to use is not listed.

Highlight <New Data Source> and select the OK button.

32. With Excel 97 select Get External Data followed by Create New query. With Excel 2002 select Import 
External Data followed by New Database Query.
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Create New Data Source Screen - Step 1

The Create New Data Source screen is displayed. 

1. Enter a name for the data source you are creating. The data source name can be anything you 
like. 

Create New Data Source Screen - Step 2

2. Select the driver for the database you want to access.

For the OSAS data files, select the BASIS ODBC Driver 32 Bit33

33. If you are using the 2.3 or 3.0 version of the ODBC Drivers, select BASIS ODBC Driver.
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Create New Data Source Screen - Step 3

3. Connect to the data source configuration file.

Click the Connect button.

BASIS ODBC Driver Data Source Setup Screen

The BASIS ODBC Driver Data Source Configuration screen is displayed. 

Enter information for the following fields:

Select the Advanced button.

Field Description

Data Source Name This field is unavailable with Excel and Query data sources. 

Description This field is unavailable with Excel and Query data sources.

Database Enter the path and filename of the configuration file you created with 
the Edit CONFIG.TPM function.

Use the Browse button to search for the file. The default location is the 
RWdata directory in OSAS.
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Basis ODBC Driver Data Source Setup Screen

The Options section is displayed.

Enter information for the following options:

Option Description

Read Only Access Check this box if you are using the Read/Write version of the ODBC 
Drivers and you want this data source to allow read only access. Any 
changes made to the files are not allowed with read only access.

Disable Use of Math 
Coprocessor

Check this box, if you want to disable the use of the math 
coprocessor. 

On machines with math coprocessors, the ODBC Drivers may be able 
to use the coprocessor to enhance the speed and accuracy of the 
functions.

Do Not Read or Write a 
File With Non-Zero 
Access Count in Header

Check this box if you want to prevent the access of a file that has a 
non-zero access count stored in the header of the file. 

A non-zero count may indicate a damaged file.

Enable Floating Network 
Lock Byte

Check this box to enable the older, slower file-locking scheme, which 
allows for standard access across the network.

Force File Length Update 
on Fat (DOS) File 
Systems

Check this box to force MS-DOS to update the length of a dynamic 
file after any changes are made to the file.
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Basis ODBC Driver Data Source Setup Screen

Option Description

No Shadow Dictionary 
Consistency Check

Check this box to prevent a Shadow Consistency check at connection 
time. 

This option will allow you to make faster connections to your OSAS 
data.

Fast Connect Check this box to allow for the fastest connection to the OSAS data.

This option is required if you are using the 1.1 version of the ODBC 
Drivers. 

Allow Multiple Reads in 
a Record

Check this box to allow multiple read processes to access the key of a 
keyed file.
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Basis ODBC Driver Data Source Setup Screen

Field Description

Log File Location Enter the path and filename for the log file. This file is used by the Log 
Error Messages, Log Function Calls, and Log File Access for Query 
Optimization options.

Network User ID If you are using a data server with OSAS, you must enter a valid 
network user ID to use with this data source file. If you do not enter a 
valid user ID, you will not be able to access your OSAS data stored on 
the data server. 

Root, Admin, Supervisor, and Administrator are not allowed.

Read Timeout Enter a number between 0 and 255 to indicate the number of seconds to 
wait for a locked record to become available. The default is 10.
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Basis ODBC Driver Data Source Setup Screen

Field Description

Date Column Suffix Enter the suffix(es) of the columns that are to be converted to the OEM 
date type selected in the OEM Type field.

More then one suffix can be entered. If more then one suffix is entered 
separate each with a comma. 

Date Types By default, the numeric columns that end in the Date Column Suffix 
are treated as Julian Numbers and converted to SQL Dates. 

If you are using an OEM database that uses non-Julian numbers for the 
data format, select one of the OEM data types listed in the combo box 
to indicate your OEM date preference for columns ending in the Date 
Column Suffix.

Translate Click this button to select the Microsoft Code Page Translator or other 
ODBC character translator.

Translation The translator selected, if any, with the translate button is displayed.
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Create New Data Source – Step 4

The Create New Data Screen is re-displayed. 

4. Select an optional table for your data source. This table is selected by default, whenever you use 
this data source, but you can always select any table available.

You can also save your user Id and Password with this data source.

Click OK when finished.

Choose Data Source Screen

The Choose Data Source screen is re-displayed.

Place a check in the Use the Query Wizard to create/edit queries field, highlight the data source 
created and click OK.
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Using the ODBC Administrator to create the data source

ODBC Data Source Administrator

Create a Data Source with the 32-bit ODBC Administrator in the control panel.

Select File DSN for use with Excel and Query

Click the Add button to create the new data source.

Option Description

User DSN Creates a data source for this machine that only the user creating it can 
access.

System DSN Creates a data source for this machine that anyone who uses this machine 
can access.

File DSN Creates a data source that can be shared by users who have the same 
drivers installed.

Drivers Displays the list of installed ODBC Drivers.

Tracing Creates a log file of calls made to the ODBC Drivers. This can be used to 
aid support and debug your applications.

Connection Pooling Allows applications to reuse open connection handles, which saves round-
trips to the server.
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Create New Data Source

The Create New Data Source screen is displayed select the Basis ODBC Driver.

Select the Next button.

Create New Data Source

Enter a name for the data source or browse to an existing data source.

Click the Next button.
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Create New Data Source

The last screen displays summary information about the type of data source, name and driver used to 
create the data source.

Click the Finished button if everything is correct or click the Back button if you need to edit any of 
the displayed information.

BASIS ODBC Driver Data Source Setup Screen

The BASIS ODBC Driver Data Source Configuration screen is displayed. 

Enter information for the following fields:

Select the Advanced button.

Field Description

Data Source Name This field is unavailable with Excel and Query data sources. 

Description This field is unavailable with Excel and Query data sources.

Database Enter the path and filename of the configuration file you created with 
the Edit CONFIG.TPM function.

Use the Browse button to search for the file. The default location is the 
RWdata directory in OSAS.
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Basis ODBC Driver Data Source Setup Screen

The Options section is displayed.

Enter information for the following options:

Option Description

Read Only Access Check this box if you are using the Read/Write version of the ODBC 
Drivers and you want this data source to allow read only access. Any 
changes made to the files are not allowed with read only access.

Disable Use of Math 
Coprocessor

Check this box, if you want to disable the use of the math coprocessor. 

On machines with math coprocessors, the ODBC Drivers may be able 
to use the coprocessor to enhance the speed and accuracy of the 
functions.

Do Not Read or Write a 
File With Non-Zero 
Access Count in Header

Check this box if you want to prevent the access of a file that has a 
non-zero access count stored in the header of the file. 

A non-zero count may indicate a damaged file.

Enable Floating Network 
Lock Byte

Check this box to enable the older, slower file-locking scheme, which 
allows for standard access across the network.
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Select the OK button to save the data source setup.

Option Description

Force File Length Update 
on Fat (DOS) File 
Systems

Check this box to force MS-DOS to update the length of a dynamic file 
after any changes are made to the file.

Fast Connect Check this box to allow for the fastest connection to the OSAS data.

This option is required if you are using the 1.1 version of the 
ODBC Drivers. 

Allow Multiple Reads in 
a Record

Check this box to allow multiple read processes to access the key of a 
keyed file.

Log File Location Enter the path and filename for the log file. This file is used by the Log 
Error Messages, Log Function Calls, and Log File Access for Query 
Optimization options.

Network User ID If you are using a data server with OSAS, you must enter a valid 
network user ID to use with this data source file. If you do not enter a 
valid user ID, you will not be able to access your OSAS data stored on 
the data server. 

Root, Admin, Supervisor, and Administrator are not allowed.

Read Timeout Enter a number between 0 and 255 to indicate the number of seconds to 
wait for a locked record to become available. The default is 10.

Date Column Suffix Enter the suffix(es) of the columns that are to be converted to the OEM 
date type selected in the OEM Type field.

More then one suffix can be entered. If more then one suffix is entered 
separate each with a comma. 

Date Types By default, the numeric columns that end in the Date Column Suffix 
are treated as Julian Numbers and converted to SQL Dates. 

If you are using an OEM database that uses non-Julian numbers for the 
data format, select one of the OEM data types listed in the combo box 
to indicate your OEM date preference for columns ending in the Date 
Column Suffix.

Translate Click this button to select the Microsoft Code Page Translator or other 
ODBC character translator.

Translation The translator selected, if any, with the translate button is displayed.



E-216

Creating a Data Source

ODBC Data Source Administrator

The data source is listed in the ODBC Administrator Box. Click OK to exit
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